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Unit 1: Introduction to Excel

Learning Outcomes

1. Learners will be able to define business analytics and explain the significance of Excel in business
analytics processes.

2. Learners will comprehend various data types, formats, and methods of importing data into Excel to
facilitate data analysis.

3. Learners will identify key functionalities of Excel used for data review and analysis in business
decision-making.

4. Learners will apply Excel tools to organize, manipulate, and visualize data effectively to support

business insights.

Content
1.0 Introductory Caselet
1.1 Introduction to Business Analytics and the Importance of Excel
1.2 Data Types and Formats in Excel
1.3 Methods of Importing and Reviewing Data in Excel
1.4 Key Functionalities of Excel for Data Analysis
1.5 Summary
1.6 Key Terms
1.7 Descriptive Questions
1.8 References

1.9 Case Study

1.0 Introductory Caselet

Get Data Smart: How to Use Excel and SQL to Discover Business Insights <8 " Get Data Smart:
How to Use Excel and SQL to Discover Business Insights"
Neha is a new business analyst who has recently joined a fast growing e-commerce startup. Her

manager requests that she research how customers shop to determine any patterns and improve sales
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strategies. Neha is excited but a bit daunted: She knows she has lots and lots of sales data in various
shapes — CSV files, Excel spreadsheets and even data scraped from the company’s online store.
Along the way, she faces several difficulties after starting to work. Organising data There are several
things Lorraine finds herself struggling to organise data in a way that makes sense and is effective:
She’s always bending over backwards trying to find the most important metrics she needs to track
Her eyes hurt just for trying to spot increasing/decreasing trends. She knows that Excel is powerful
to analyze the data but she doesn’t know how to harness its features in the right manner. How does
she clean and structure this data? What skills will she apply when solving problems? How can she
produce more than just a set of visualizations to show her team?

Neha knows that she has nothing to lose and everything to gain by learning how to do business
analytics in Excel — not only in her current job, but also in her opportunity to make evidence-based
decisions. As she navigates through this process, she has decided to investigate various data types,
importing avenues and major Excel functions that will help to take raw data to shinning business

insights.

Critical Thinking Question
How can Neha use Excel's data analysis tools to clean up, sort and find hidden gems about customer

purchase patterns in order to help her company make better sales categories?
1.1 Introduction to Business Analytics and the Importance of Excel

Business analysis is particularly useful in structuring data of what has happened and applying
scientific methods to business data to predict, steer and make decisions towards organizational goals.
Data-driven: Business users employ statistical tools and visual data models to uncover what their
businesses’ data has to say about trends and relationships. In today’s rapidly changing business
environment, analytics enables companies to differentiate themselves from competition, to do it
better with customer satisfaction.

Studies Signs typically generate vast bodies of data from their various customer purchase records,
market trends and other company activities. When this data is analyzed properly, organizations are
able to:

e Drive smarter and faster decisions by using data-driven insights.

e Discover better business paths and identify weak points in your operational system with data.

e Analyze market trends to combine a plan to safeguard our future business.

e [ecarn how customers behave and what they prefer to inform better service.
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Fig 1.1 Microsoft Excel

Microsoft Excel remains the leader in business analytics tool usage because of its ease of access,
easy use and great ability for data processing.

Many organizations of all sizes rely on Excel to produce incredibly powerful and complex data
manipulation for everything from managment, analysis and generating Power Points.

Some of the Factors that Determine the Significance Of Excel in Business Analytics :

Data Organization and Management:

e The data set management capabilities such as tables, the filters, and the sorting systems in
microsoft excel helps business users to manage large volumes of data efficiently.

e Organisations require Excel to maintain data, recover records and manipulate the data in
structured formats.

Data Analysis Tools:

e e Based on data analysis, using built-in Excel function like SUM, AVERAGE, VLOOKUP and
INDEX/MATCH to help users.

PivotTables can handle amounts of data easily with a simple, fast summary engine. Visualization

Capabilities:
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e Excel helps you to create effective data visualization tools (bar chart, pie chart, line and
histogram).

e With conditional formatting, you can highlight important data trends or track the unusual or
unexpected.

Statistical and Predictive Analysis:

e More analysis features such as regression analysis pair with trend lines and forecasting tools to
help you better identify variance, trends and patterns.

e Users can avail some advanced statistical features via the Analysis ToolPak add-in.

Automation with Macros:

With macros and VBA (Visual Basic for Applications). Excel performs the automatic repetition of
a same task assuming that no two tasks are identical.

e They help save time and data processing power and are faster. Scenario Analysis and Decision
Making:

e Companies have strong tools to analyze the many possible outcomes and even input various
variables by using Goal Seek and Scenario Manager.

e Assists with financial modeling and strategic planning. Cost-Effective and User-Friendly:

Excel can be an inexpensive analytics tool, but it demands literacy with the package before you
begin using it.

It works on all platforms so users can deprive it from all over the globe. Typical Business Analysis
Stats with Excel

- Sales Analysis: Used as tools for analysis, to aid in recognizing best sellers and help forecast of
what the customers will want next.

- Financials: You are updated with their user created Balance Sheets, Income Statements as well as
Budget forecasts by their key Financial statements.

- Stock Control- Tracking stock capacity and purchasing patterns.

Marketing Analytics - It’s to do with the comparison of marketing result as against specific customer
markets data.

- HR Analysis: Analysing the employee ranking and employee's attrition.

1.1.1 Types of Business Analytics
Business analytics comes in three flavors —none of which taste like Braums—and each type offers

insights that help companies make smarter decisions.
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Descriptive Diagnostic Predictive Prescriptive
Fig 1.2 Types of Business Analytics

Descriptive Analytics

take action to improve outcomes. Purpose of Descriptive Analytics:

This allows organisations to see the corporate history at business and topic level.

How Descriptive Analytics Helps: 1.

combinations of products they purchase.

reduction of their sale productivity and customer feedbacks.

orders this quarter, they generated the sales that they were hoping for.

Data-Driven Decision-Making: Companies use learnings to make informed decisions about the
future. In the light of our research, some findings are important for offering us more effective

recommendations for planning business development in the future.

Descriptive Analytics Use Cases:

Retail: Past sales data allow store owners to understand which products yield the highest sales for
various Seasons.

Example: Walmart looks at past sales data so it can order products that have a track record of being
in style, such as winter wear or barbecue goods during their seasons. Amazon works through
customer purchase data by adjusting their stocking strategy and making product recommendations
in times when previous customers have purchased similar items.

Health care: Hospital workers analyze clinical data to identify when flu infections occur most
frequently within each year.

Example: The US Centers for Disease Control and Prevention (CDC), which is drawing on data
submitted by health care professionals, tracks flu trends when hospitals are being forecast for demand
in busy times.

They were using descriptive analytics to observe day-to-day numbers of patient admissions with

COVID-19 in order to reserve scarce resources like Intensive Care Unit (ICU) beds and ventilators.
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Finance: A company analyzes its latest finance data each quarter to discover patterns of change in
revenue and spending. They find this annual sales high in the fourth quarter and, as a result, push
above-average sales efforts during the season.

Example: Utilizing transaction data from Mastercard, Scrapped provides descriptive analysis, of
interest to financial institutions in identifying when habitual consumer spending cycles occur.

The PayPal analytical platform analyses historical flow data between customers and the company,
to understand patterns of customer behaviour during different times of day which can then inform
fraud protection.

Marketing: Business analyses the performance of its most recent social media campaign through
social media metrics (like, comments, shares). Their data insights can help them understand what
types of content is working and how to better plan the next step.

Case and Point: Coca-Cola measures 'Share a Coke' success by examining social media how. They
use the information in future strategic planning for upcoming marketing efforts. Since Spotify
collects information about user listens, the service knows what's trending musically from season to
season—enough so that it can plan its promotional schedule accordingly including the popular
"Wrapped" year-in-review promotion.

E-commerce: It doesn’t guess at web traffic, but instead uses data to show how frequently customers
visit each product category. They then use this information to figure out what their buyers want most
so they can put adequate focus on their ad promotions.

For example: Shopify and Flipkart track consumer interactions to measure statistics like page views
and time spent in category against electronics or clothing. It thanks to the tracking system that they
are able to identify the most visited areas of their products and directly advertise with precision

based on customer taste.
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Fig 1.3 Examples of Descriptive Analytics

Did you know?

e 80% of Business Insights is from descriptive analytics enabling businesses to compile historical
data to take actionable decisions.

® 65% of Organisations look to descriptive analytics to monitor performance, and uncover
operational efficiencies.

e In businesses, 90% of Data Analysis Efforts are only used to understand past performance
(descriptive analytics).

KPIs: Public organizations monitor operational success with certain key performance indicators that
allow for monitoring of operations across domains. They evaluate productivity by monitoring
numbers of dollars, up-to the minute-sales velocity and cost of acquiring new customers to product
flow speed throughout their systems. KPIs are relied on by organizations to measure how well they
have achieved their goals the metrics used to measure what specifically constitutes success.

Trend Analysis: Future forecast of business performance based on analysis of changes in data
collected over time. Product supply time when you open a store is calculated by analyzing user

movement pattern with high season sales information.

Predictive Analytics
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Statistical model but data-driven with ML algorithm In predictive analytics, the primary analysis in
predicting future market movements is statistical model but it's data-driven using machine learning
algorithm. Predictive analytics allows companies to base their decisions on historical data and learn
from it, predict risk areas, as well as discovering new growth opportunities. By doing so, businesses
can be warned of potential problems and seize opportunities to expand, or to optimise its operations
leading into an educated decision-making process. Business operations rely heavily on predictive
analytics as an instrument of strategy for organizational functioning.

Did You Know?

Predictive Analytics-Healthcare: In this space, predictive analytics is used to predict patient health
condition which enables care delivery before it becomes a problem and refining treatment.

Purpose of Predictive Analytics

What Predictive Analytics Aims to Do: It is the goal of predictive analytics, in a nutshell, to reveal
data patterns and gain insight from what is already known about a situation by using that knowledge
to build predictive models capable of forecasting future outcomes. It allows businesses to:

e Strategic shifts will also make it necessary to anticipate the next ones.

Administrative practice for identifying potential systematic errors is predictive. Predictive analytics
ensures that operational efficiency is optimized by forecasting market predictions and dispensing
the necessary resources.

e Individual service delivery will follow by predicting consumer behavior patterns and serve their

customers in a better way.

Finance
Assesses loan defaults Supply Chain
Healthcare by combining client data Management
ARl dical with financial histories. Examines market
nalyzes medica
records to predict patterns to forecast
hospital readmissions inventory demand and
and personalize prevent stock issues.
treatments. @
BA\\ Im// &Z Human
Retail oy Oim Resources
Uses historical purchase 0 fj B Q. Forecasts employee
and seasonal trends to turnover to implement
optimize inventory and Q Q Q ﬁ(@}?\ retention strategies and
pricing. (\) reduce costs.

Q
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o

Fig 1.4 Examples of Predictive Analytics
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Retail:

Use Case: Sample customer purchase behaviours and seasonal patterns as Data input to the
forecasting model that retailers use for future revenue numbers wants. By an analysis on a consumer
profile (customer information) and preference of a product in a market, items can be predicted
effectively so that inventory management can be determined.

Benefit: With this insight, businesses can improve inventory management practices down to
minimizing inventory waste and run more effective marketing campaigns. Personalized
recommendation from predictive analytics retailers Generate etailers gives a personalized
recommendation to each of its customer that will not just create more sales but the loyalty for their
customer as well.

Example:

Amazon: Transforming its recommendation system Amazon also employs predictive analytics -
asymptotic improvement in automating data with buying behaviour and customer preferences
together as well as personal browsing information. It's the personalized recommending feature that
makes majority of Amazon's revenue, by pushing big chunks of sales through these
recommendations.

Walmart- Retail giants such as Walmart leverage predictive analytics to analyze customer’s purchase
history, browsing behaviour and other demography related data, and make personalized product
recommendations. For example, if a customer is more likely to shop for apparel items more
frequently, the system would understand that they may now need new ones and analyze what clothing
they may own in terms of shoes, shirts and pants etc. keeping that item context in mind it should be
suggesting relevant clothes to them. In fact, it enhances customer experience and increases sales and
customer retention.

Healthcare:

Usage: Integration of patient history, treatment schedule and demographic information by clinical
experts is useful for readmissions prediction. The predictive model helps determine which patients
are more likely to experience complications and to be re-admitted to the hospital.

Advantage: Investigating via predictive modelling contributes to personalised clinical treatment
leading to improved patient outcomes without imposing additional hospital costs. They can predict
diabetes and cancer because they find the signs of potential health problems before fully fledged
symptoms become apparent, so that doctors can act early.

Example:
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Johns Hopkins Medicine: The hospital tracks ICU patient status via predictive data analytics that
recedes through clinical signs to detect early warning signals of impending medical conditions (and
preempt complications).

Blue Shield of California: Predictive analytics Blue Shield looked at claims information when
evaluating patient history to direct preventive care at those expected to be high risk, thus driving
down usage of the emergency room for customer visits.

Finance:

Application:In predictive modelling, the client’s behaviour and clean financial data is utilized by
lenders to measure the risk estimation of loan defaulter using the credit score and income levels.
The platform enables businesses identify its at risk borrower profiles.

Benefit:Utilizing predictive analytics and operations assists decision maker in superior decision
making across all stages of credit underwriting, which leads to reduction in NPL. Predictive
analytics software allows for instant discovery of suspicious spending.

Example:

JPMorgan Chase: The bank employs predictive analytics to understand whether a transaction is
fraudulent by comparing recent behavior to historical performance data and spotting outliers.

FICO Score: The FICO model is the predictive modeling of an individual's likelihood to pay that
becomes a tool for banks to priice credit and other interest items.

Supply Chain Management:

For example, businesses employ market trend analysis and incorporate it with customer information
to predict future inventory needs and vendor shipping performance. With predictive analytics
companies to make more informed decisions regarding their procurement systems and supply chain
inventory control.

Pro #4: Enables companies to avoid overstock and out-of-stock of inventory, ensuring smooth flow
in supply chain operation. Businesses that leverage predictive analytics increase their capability to
forecast demand, manage suppliers and schedule deliveries.

Example:

Procter & Gamble (P&G): Utilizing Predictive Analytics, P&G is able to reduce inventory levels by
slotting written demand patterns and vendor performance in Logistics Costs as well as by increasing
Manufacturing Productivity.

UPS: The company’s advanced forecasting uses data on previous traffic activity, weather and
delivery times to develop the most efficient delivery routes which reduce fuel idling time.

Human Resources:
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Use Case: Predictive models use employee work place morale measurements and to identify
expected employee attrition events, along with the profitability of said turnover.

Benefit By focusing on retention and employee engagement, HR dept’s can develop effective
programs that reduce the cost of search and training by maintaining continuity and decreasing time
to proficiency. Companies find emerging leaders via predictive models analysis.

Example:

IBM: At IBM, predictive analytics allows the company to predict the workforce by analysing
satisfaction with travel time and compensation benefits. Early identification allows the organization
to pursue preventative retention measures which eliminate future costs of hiring and training their
replacement.

Google: Better retention and heightened employee engagement are achievable if Google can analyze
performance results with employee surveys also measuring data about the workplace.

Diagnostic Analytics

Diagnostic analytics- This is the business analytics that concentrates on why things are happened in
past and also to support future pulling. It falls in the middle of Descriptive Analytics (tells us what
happened) and Predictive Analytics (tells us what will happen). Diagnostic Analytics Diagnostic
Analytics allows organizations to identify patterns, correlations and causal factors that influence
business performance, typically accomplished with the help of various statistical techniques an data
exploration methods.

Objectives of Diagnostic Analytics:

Break down the business trend of problem observed into its practical elemental causes.

- Pattern Recognition: HT study some of the relations between a number of factors in the past data.
- Dynamic Decision Support — Stream actuating data that impact operational outcomes.

- Predictive and Prescriptive Analytics Interface An interface to the forecasting (predictive) models,
the planning/optimization (prescriptive) models via the Management Model.

Key Techniques in Diagnostic Analytics:

- Drill-Down and Exploratory Analysis — Effortlessly break down aggregate statistical information
for diluted root cause analysis.

- Correlation and Regression -To determine how much the variables are related and to establish
cause and effect.

- RCA (Root Cause Analysis) — Identifying what has led the business logic to its current result.

- HTS Analysis — Discovering patterns and anomaly behaviors by modeling historical trends over

time.
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- Comparative Analytics — Comparing datasets in different time periods, territories or lines of
business to discover differences.

Use Cases of Diagnostic Analytics in Business:

- Finance: Reasons for decreasing income (changing market) or changes in consumer behavior.

* Health: Why hospital readmissions spiked by looking at patients’ back stories and medical
outcomes.

- Marketing: Explanation about why a recent ad campaign that did not perform well, based on
engagement rates, demographic response, and environmental factors.

Supply Chain Management: Uncovering the cause of logistical delays is part of supply chain
management, reviewing shipping logs and a suppliers' performance.

Diagnostic Analytics as Part of the Business Analytics Model:

Diagnostic Analytics is a part of the process in data-driven decision-making, it falls between
Descriptive and Predictive Analytics:

- Descriptive Analytics: What has happened? — Captures history and trends.

- Diagnostic Analytics: What happened? — Explores causes and correlations.

-? Predictive Analysis — what might happen next? — Trend in variables considering the previous
information.

- Treatise: How will it be done? — Suggests you the best possible move as per estimation.

Prescriptive analytic

Prescriptive analytic appliances deliver actionable suggestions that help improve predictions and
decisions, while deploying neural networks to analyze data for trends are used to predict optimal
results. This tool is utilized in practically all sectors of the economy to optimize processes and offer

innovations that contribute to the satisfaction of customers.
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Fig 1.5 Prescriptive Analytics

8 — Retail: Prescriptive analytics are used in retail to develop bespoke customer experiences and to
maximise inventory holding.

Examples:

- Personalized Product Offer: The analytics recommends the product based on the specific customer
preferences from customers’ browsing and buying behaviour for such retailers.

Advantage: By incorporating better customer satisfaction, there would be an advantage of reduced
inventory cost and increase in sales performance.

Healthcare: To create better care results, cost savings and efficiently used resources in operation,
healthcare institutions use prescriptive analytics.

Example:

Treatment Recommendations: The system processes patient data from clinical records and
determines the executive-driven recommendations for ideal care that can be given in terms of
available resources.

Finance: Prescriptive analytics allows financial institutions to make decisions by providing them
with actionable insight on investment opportunities, and is used to design better risk management
processes as well as fraud detection algorithms.

Examples:

- Investment Consultation: Banks and other financial institutions use market analysis, financial risk

evaluation and detailed investor profiles to construct tailor-made investment plan for clients.’
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- Fraud Protection: Electronic systems are checked by computers provided by the financial
companies which help to minimize fraud.

Operations: This approach in prescriptive analytics enables organizations to further optimize their
logistics networks & supply chain management, and employee services - thereby reducing costs
while improving efficiency.

Examples:

- Route Optimization: By means of prescriptive analytics, logistics companies can write the best
delivery routes that maximize speed and minimize fuel burn.

- United Parcel Service million gallons of day by basically was conserving diesel fuel, if you want
to look at it that way, routing and optimizing delivery routes through their ORION system.

\\, with a demand pattern dependent type so that both the effectivity and the expense are minimized.
Marketing:

Through the use of prescriptive analytics, marketers know exactly where to spend budget with
maximum impact and can stretch their campaigns into highly measurable outcomes.

Examples:

Advertising budget optimization: Prescriptive analytics recommends how best to allocate
advertising budgets by accounting for expectations surrounding the return of investment of
advertising on different mediums.

Google Ads prescriptive analytics will suggest where to move budget to deliver the best
performance in a campaign.

Customer segmentation and engagement : By using prescriptive analytics, organizations can
identify profitable customer groups and design ‘intelligent” engagement strategies for each.
Coca-Cola uses prescriptive analytics in order to create programs that appeal to consumers.
Benefits: The most effective Prescriptive Analytics is perfect for a few reasons: it maximises your
Marketing Return on Investment in two waysl and delivers increased customer engagement and,

ultimately, more Conversions.

Activity: Business Data Analysis with Excel
The idea is that companies use data to make better decisions. As a business analyst, you need to
analyze a company’s sales data in Excel for trends and insights.

Instructions:

Z'l—.l turnltln Page 16 of 48 - Al Writing Submission Submission ID  trn:oid:::3618:127056669



Z'l_.l turnitin  Page 17 of 48 - Al Writing Submission Submission ID _ trn:oid::3618:127056669

Choose a Source Dataset You must use some set of data that we can work with (some example
sample data is provided) - e.g. sales units, product types, customer localities, or dates of purchase.
Format Data in Excel: Place your data into an Excel table and use the sorting and filtering capabilities
to easily target specific types of dates.

Analyse Data: Calculate analytics in Excel, use basic Excel functions like SUM, AVERAGE and
COUNTIF to get the total sales, average revenue per region, how many products were sold by each
category.

Visualize the Data: Create charts and graphs (such as bar charts, line charts, and pie charts) to
illustrate sales trends and highlight key patterns.

Leverage Conditional Formatting: Highlight top-performing products through conditional
formatting to easily identify best-selling items.

Make Data-Driven Recommendations

Respond to the following according to your reading:

The bestselling products/locations?

What is the sales pattern overtime that you observe?

What should the company do to increase sales in light of your information?

1.2 Data Types and Formats in Excel

Data types and format in ExcelDifferent formats are used in the management of data in Excel.

In Excel, handlers can process and also visualize their information when they doing the analysis. |
need (due to the fact that they play a critical role" in ensuring business accuracy via e.g Financial
Modelling, Data Analysis & Reporting when using Microsoft Excel"..:)) to have good knowledge

of "Data Types and their formatting techniques."

How toRecognizede Different Kinds of Data in Excel
In Excel you can check what type of data a cell or range of cells contain by selecting the cell in
question and right-clicking. Then, click on Format Cells. The available data types (for example,

Number, Date, or Text) will be shown in the Number tab here.
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Format Cells

Numbsr Alignment

Category:

fGenea Y

Number
Currency
Accounting
Date

Time
Percentage
Fraction
Scientific
Text
Special
Custom

?
Font Border Fill Protection
Sample
General format cells have no specific number format.

Fig 1.7 Selecting the Format Cell Option Fig 1.8 List of Data Types in Excel

Or, you can go to the Number group on the Home tab and see a few data types.
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Fig 1.9 Data Types in Excel

1.2.1 Data Types in Excel
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Excel Data Types specifies the kind of value stored in a data set. Adequate comprehension on
different data types is indispensable to support good practices when analyzing and visualising the
data, while trying to take decisions. In Excel, data can typically be sorted into one of two groups:
Numerical (Quantitative) Data and Categorical (Qualitative) Data.
Numerical Data (Quantitative Data)
Numerical data are numbers which can be assigned a numerical value. Again it is of two types:
Discrete Data:

Made up of numbers that can be counted.

It is not divisible into smaller units in a meaningful way.
Examples:
\begin{itemize} \item The size of a class (\textit{\textbf{e.g.}\ 25, 30}).
- Number of parking cars.

Quantity of selling within a 24-hour period.
Continuous Data:
Describes values that can be represented as a number within a range. Includes decimal or fractional
values.
Examples:

Height of a person (5.8 ft).

Temperature (such as 37.5 C).
- Distance traveled by a vehicle (e.g., 12.4 km).
Categorical Data (Qualitative Data)
mcat:C0O1" categoryl3-id="LC4 bucketCats tractable.type : A property of some data model cases
that allows factoring a list into the base of an expression and a multiple inside might also include
numbers for categorical attributes) Categorical: Non-numeric values used to classify objects into
groups or labels. It is divided into two types:
Nominal Data:
Symbolizes or annotates categories as unordered or unranked. For labeling only.
Examples:

Product attributes (Red, Blue, Green).

Types of fruits (Apple, Banana, Mango).

sex (Male, Female, Other).

Ordinal Data:
- Symbolizes or tags categories/items with a meaningful order over ranking.

- R is not a symmetrical function of ranks.
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Examples:
Satisfaction of customers is (Low, Medium and High).
- Level of schooling (Primary, Secondary, Tertiary).

- Ratings for movies (1 star, 2 stars, 3 stars etc.).

1.2.2 Data Formatting in Excel

In Microsoft Excel, the data entered in a worksheet is all formatted using the same format by default
and this tends to make the data look monotonous, drab and downright confusing. It features a
formatting toolspool which allow you to manipulate data in way that its meaningfulness is retained
and only the appearance of it modified.

How to format in Excel?

Below is the procedure for applying the formatting:

e Choose the range of cells to apply the format to.

e Chose the correct formatting instrument in the toolbox.

e Style is viewable on the sheet.

Contain formatting tools for text and the cell in appearance that In the Home Tab [ Font Group ] on

the Ribbon.

Home Insert Draw Page Layout Formulas Data EEY
=) . = | — I G v
‘—_\ = 36 Arial v|[10 v A~ A~ =9
- | I" _\_| v 'L' :: g :: — v
Paste Uu -~ v S v A v ——
g B| I |Y — e €<= 9= Srv
Clipboard Font Alignment

Fig 1.12 Formatting in Excel

Font
The font parameter will alter the way text is written in Excel. There are plenty of fonts to select
from when it comes time to make data look professional, fun or just plain different.
How to Apply:
e Highlight the cell(s) you wish to format.
Select the Home tab in the ribbon.
e C(lick on the Font drop down arrow and select a font style (e.g., Arial, Calibri, Times New
Roman).

Example:

Z"j turnltln Page 20 of 48 - Al Writing Submission Submission ID  trn:oid:::3618:127056669



zﬂ turnitin Page 21 of 48 - Al Writing Submission

Submission ID trn:oid:::3618:127056669

A cell would look goofy in a “Comic Sans MS” font, but formal in a “Times New Roman.”

Font Size
Page Layout Formulas Data Review View Help
ComicSansMS |11 ~A" AT = = |£| D~
B I U-H- O AW =Z==EE
T
N Font I~ Alignmg
fx 24-01-2025
e D E F G H

| 24-J qn-25_

Times New Roman ~|[11 | A" A"
B I U Hie v A~
Font I~
Sx  24-01-2025
(€ D E F

| 24-Jan-25_|

Fig 1.13 Fonts in Excel

93.Binding source : With this selection you have option to change the text size within a cell,..you

can make it bold or Make it smaller as per your content looks good and readable.

How to do it:

e Click on the cell(s) that you would like chosen.

e From the Home tab, scroll down to Font Size.

e Select a size of 10, 12 or 14 point.

B
ter

I~

Jx

<

Times New Roman ~|[10  v| A" A"
I u-H-|lav A~
Font N
24-01-2025
D E F
24-JTan-25 |
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Fig 1.14 Font Size in Excel
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Times New Roman v[[10  ~| A® A"

B I U-v v &dv A
I

N Font N

Page Layout Formulas Data Review

View Help
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v
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Alignn|
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Increase Font Size

Make your text a bit bigger.

€ D E v

| 24-Jan-25_|

< T

Example:

Fig 1.15 Increase/Decrease Font Size

A font size of 16 makes the text easily readable for presentations, whilst a size 10 is great for tight

reports.

Increase/Decrease Font Size

Rather than click on a point size, you can apply them, quick as a mouseclick with the

increase/decrease capacity.

How to Use

e Highlight the text you want to change.

Click the Increase Font Size button A A on the Home tab or Decrease Font Size button A'V¥ on the

Home tab.

Insert Page Layout Formulas

Data Review Vie

i TimesNewRoman v[[10  +| A" AY = =
Py v == W (. o

B| I U+ .+ v Ay ==
fmat Painter —
rd ~ Font =

Bold (Ctrl+B)

Make your text bold.

B — o = F g
lTotal Sales _|
Fig 1.16 Bold/Italic in Excel

Example:
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If you ever come across text in a cell that is just too small to read, press the increase button once or

twice and everything will instantly become readable.

Bold and Italic

For marking information and identifying the most important datapoints.
Bold (B):

e Thickens and darkens text.

e Extremely helpful when emphasising headwords or important values.
Italic (I):

e Slants the text, it has a special look which you may like or dislike.

e Flagged for special information or references.

How to Apply:

e Highlight the text.

e Please find the B for bold or I for italic in Home tab.

Page Layout Formulas Data Review View Help

Times NewRoman 10~ A" A~ = = ‘E‘ D~
B I U-vHva-Aw = ==E=
3
N Font I~ Alignnf
ﬁ 24-01-2025 Increase Font Size
Make your text a bit bigger.
C D E v < A

| 24—Jan—25_|

Fig 1.15 Increase/Decrease Font Size

Example:

"Total Sales" (BOLD) It is for Reporting purpose.

“Note: Data is fictitious” (Italic) - to emphasize additional information.
Underline

Insert a horizontal line below your selection to emphasize it.
Types of Underline:

e Single Underline: Places one line under text.

e Double Underline: Puts two lines for double the notice.

How to Apply:

e Highlight the text that you want to underline.

e Next to the Underline (U) button on the Home tab, click More.
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e Seclect the Double Underline if needed from the drop-down next to it.

Insert Page Layout Formulas Data Review Vie

i Times NewRoman v[10  +/ A" A = =
py v~ . [

B| I U~ v ==
Fmat Painter —
rd N Font N

Bold (Ctrl+B)

Make your text bold.

ITotal Sales _|

Fig 1.16 Bold/Italic in Excel

Home Insert Page Layout Formulas Data Review Vi
& cu Times NewRoman v[[10  ~| A" A" = =
[Bcopy ~ —
B 7 (U H-&-A- EE

Q? Format Painter

Clipboard & U Underline 5

D &
< fx Totl = Double Underline
z B c | D E F
Fig 1.17 Underline in Excel

Example:

Single underline for headings such as "Monthly Report"
Double underline for total such as Grand Total

Top and Double Bottom Border

Submission ID trn:oid:::3618:127056669

Borders on your tables allow you to organize and separate information, as well as make your data

more structured.
How to Apply:
e Click the range of cells that you want to format.

e Sclect the Borders drop-down at the Home tab.

e Choose Top Border, Bottom Border, or Double Bottom Border.

Border Choices
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e Top Border: Put a line on the top edge.

Page 25 of 48 - Al Writing Submission

e Bottom Border: Places a line at the bottom.

e Fat Edges: Mark the critical components.

Draws grid to highlight summary rows in financial statement.

A second bottom border below totals for added emphasis.
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Draw Page Layout Formulas Data Review View Developer
'JE\ - CK’ Arial *110 < A~ Aw ~ = =157 [General v
Paste B| I |U|~ b ) A B =z Onv B % ) o
Clipboard Font Top and Double Bottom Border :nt Number
Fig 1.18 Top and Double Bottom Border in Excel
Fill Color

Fill cells with color to highlight and make them easier to locate.

How to Apply:
e Select the cell(s).

e Press Fill Color in the Home tab.

e Choose from thousands of colors.

ewRoman+J10 AT A | = =[=] ¥~ BAE
U B [PYAY === == Bwe
Font High-contrast only (@ off)
Bal Sales Theme Colors
- H HEN O
[Totar s
.III||||||
Standard Colors
I EEEEN
No Fill 4
More Colors..
Example:

Fig 1.19 Fill color option

Overdue tasks are presented with red fill color.

7 turnitin
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Different colors are used to indicate different elements of the table.

Font Color

Submission ID trn:oid:::3618:127056669

It can change the text to a particular color or make it stand out in some other way, such as by

matching it with a theme.

How to Use:
e Sclect the text.

o Press the Font Color icon in the Home tab.

® You can choose a color from the color palette.

Roman~[10 +/A" A" = = |;| v 2b, Wrap Text |Custom
Uv EHv OvAY] = = = = = EMerge&Center v &3~
Font High-contrast only (@ off ) ~
I Sales B Automatic
B E Theme Colors J o
rasie | [l EEEEEEE
Standard Colors
More Colors.. Purple
Sample
v Good contrast
Fig 1.20 Font Color
Example:

e Great to use green font color when the growth value is positive.

e Format the losses in red colour font.

Did You Know?

The first version of Excel was published in 1985 for Macintosh. Microsoft didn’t even release Excel

for Windows until 1987 and eventually it overtook Lotus 1-2-3 in popularity as the dominant

spreadsheet application! (Source: Britannica).

Other Advanced Formatting Options

7 turnitin
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In addition to basic formatting, Excel includes a variety of advanced styles and features designed to
make your data more presentable and easier to use:

e Conditional Format: A feature that enables cells to dynamically change the way they look (their
formatting) based on a set of criteria you define and allow users to identify trends or values, pick
from a group of categories, and more.

e Custom Number Formats: Users are automatically presented with which to easily choose date,
currency type and consolidated data forms for standardised data display.

e Cell Styles: With pre-set styles, users can clean up their cell formatting but still keep their
worksheet content well organized and even professional.

Themes: Employed across the entire package the consistent styling options of colour and font result
in a coordinated appearance for all aspects of your workbook

Knowledge Check 1

Fill in the blanks:

In Excel,  constructs are logical operations and can only have the value TRUE or FALSE.
(Boolean / Numeric)

Excel has several features under the tab which can be used to format cells such as font size, bold,
italics and fill color. (Home/ Data)

Excel holds  as a serial number to process calculations, or 1/1/1900 is the equivalent of one (1).
(Dates/Texts)

The  feature in Excel enables cell to automatically alter its appearance on the basis of certain

conditions. (Conditional Formatting / Cell Styles)

1.3 Methods of Importing and Reviewing Data in Excel
Excel pulls data in from other external sources as well, with support for plain text files and common
databases and Web systems. Excel enables users to conveniently interact with its interface in order

to import data automatically from multiple file forms.

1.3.1 Importing Data from External Files

You can import data from some of the popular file formats into Excel, including:

CSV (Comma-Separated Values): CSV files use a simple text format to store data, as it appears in
every single row and value is separated by commas.

Steps to import:

e Jump the table to Data tab then click Get External Data and choose From Text/CSV.
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e Application software here such applications as ERP or CRM relies on this format when exporting

data to some processing facility.

9. Q- = 05-import-and-export-data-01 - Ex..
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Fig 1.21 CSV (Comma-Separated Values) Files

Excel Files (.xIsx,.xls):

It is also directly accessible from within Excel by using an Import wizard which acts as a means of

importing data from other worksheets and making it possible to build up consolidation documents.

Steps to import:

m Open

Organize v New folder

7 ~

&& OneDrive
(3 Microsoft Excel

This PC G OneDrive
Print

-
B This PC
Share + Add a Place B Desitop
%] Documents
Browse ¥ Downloads
Publish D Music

| Pictures

[

Close

Account

P« Data(®) > Semplebxcel v & | Search Sampletx

B Videns i i€

File name: [2016_Calendarads v| (A ExcelFiles

Name Date modified

B2 2015 Calendarads 2/13/2016 10:4
51 2016_Calendarxds 1/25/2016 12:32 P)

Tools ~ I Open Ile

Fig 1.22 Excel Files

e Go through File and tap on Open and further Browse.

With Excel, one can consolidate separate departmental data into a single master report.

Text Files (.txt):
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Text files are objects, with properties that allows you to read and write line by line from or to a text

file in such a way that the space characters do not matter.

Steps to import:
e Users can locate this feature in Data tab > Get External Data > From Text/CSV.

This is primarily for systems which have the old 'spread flatfile' data back-end.

AutoSave (@ off)

File Haome Insert Diraw Page Layout Farmulas Fa

FRBm D B B

Fromm  From From Tablef Recent Existing Refresh —
Bata = Text/CSV Web Range Sources Connections All :_1\

Cuerigs &
_j'l Ersm Bl > [E Froen Wckbook
Y ,
_[j From Database From Text/CSV . G
[ By
_== From Azure > c&r| From XML

Fig 1.23 Text Files

1.3.2 Importing Data from Databases and Online Sources

Excel has features allowing you to create external links to data in databases and web-based systems
where information is current.

SQL Server/Access Databases:

In many cases mission critical business data is stored in Microsoft SQL Server or MS Access (MDB)

databases.
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Fig 1.24 SQL Access Database

Steps to import:

e (Click on the Data tab and then selectGetData, From Database, and finally From SQL
Server/Access.

Great for reporting financial data and managing customer contacts.

Web Data Import:

Using Excel's Web Data Import feature, users can now easily bring data directly to the workbook
from web pages and online services to enrich analysis and storytelling with statistics, rates data,
property valuations, company rankings and other types of public information along size any table of
numbers that has an online presence. With this feature, users can put their analysis on autopilot with
real-time updates by connecting to datasets on the web.

Steps to Import Web Data:

You'll need to navigate to the Data tab within the Excel ribbon.

Select Get Data > From Web.

You need to enter the exact URL of the page where you want this information from.

Choosing Get Data from the Data menu, then From Web displays web table alternatives. Begin with
choosing the correct table from that page and preview its data content for importing them with the
Load button. It has dynamic monitoring requirements since imported information must be

synchronised and data refresh cycles can be scheduled.
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Benefits of Web Data Import:

e Real-time tracking: The datasets are kept in sync with the latest using automatic updates of stock
prices and weather reports and sports scores.

e Time Saving Cricial data is turned into digital records without sacrificing on correction details or
stacking up old forms. o Efficient Analysis Eliminates man-made errors in gathering information,
the auto-delete feature eliminates time consuming procedures used in manual entry.

e Tailored Insights: With Excel tools, it can analyze data insights such as charts and pivots to see

the detail behind the numbers.Filter connection in pivot tables through custom regions.

File Home Insert Page Layout Formulas Review View Developer Help ArcGIS Maps Acrobat
[T Queries & Connections A .2_4 ?

@ BB L b B fm 0y [ AR

Get  From |From [rom Table/ Recent Existing Refresh — Stocks  Geography = ZJ, Sart Filter

Data ~ Text/CSV | Web Range Sources Connections Allr |2 -

Get & Transform Data Queries & Connections Data Types Sort & Filt]
Al - e
A B C D E E G H | ] K L M

i 1]

2|

= x

% |

5 | From Web

o8 @ Basic Advanced

T

8 | URL

9 i rusdikey=FIGYQFQNZKVNS6POEVAROPTO88 ocations=herndon%2C%20va

10|

11

12 | oK Cancel

13|

14|

15

. s o
Fig 1.25 Obtaining Data from Web

Example:

Stock Market Analysis: Analysts on Wall Street and independent writers use Yahoo Finance to
collaborate on real-time market data bringing in prices and activity, earnings, estimates as well as
recommendations. Paired with the basic functionality of Excel, an analyst has:

e With the new dashboards, users can now see visual of their portfolio measurement data.

e Upon choosing, your system should prompt notifications reminding you when your stock price
reaches the target level.

e Focus shifts towards Market trends and locators of profitable investment opportunities.

Power Query (Advanced Data Import):

With Power Query users can automate the process of importing data and doing necessary cleansing,

as well transforming that data from a variety of sources.
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Steps to import:
Select the Data tab, then Get Data > choose Launch Power Query Editor.

The tool allows for efficient handling of elaborate pre-analysis transformations.

Fig 1.26 Power Query

1.3.4 Advanced Review Techniques

Pivot Tables:

Pivot Tables:

You may find yourself using the Pivot Table Excel's most powerful tool. Through this, they can
efficiently aggregate large-scale data and analyze them all as a group while summarizing analysis
results and presenting them. Pivot tables (a long-standing dream of us all at tradersdna) are
established to help read the most important numbers and trends through a mass of data over process,
without having to handle manually the data.

Major Advantages of Pivot Tables:

Users can pivot data to take large date-sets and summarize it into a meaningful user-specifiing
groups.The floats must comply with the IEEE single-precision format.

" @ Segmentation - the data is segmented by using the pivot tables based on "subsets and groups
which give* in different sections a region-, product type- and date parameter.

e Trend spotting: It’s easy for users to join the dots from the data by viewing trends in pivot tables
that display seasonal changes or departmental KPIs.

e Flexibility: Pivot table that How to Prevent Pivot Tables from Forming when Dragging and

Dropping Fields Ensure ustomers see your data in the way you want, asp.
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Fig 1.30 Pivot Tables

The use case applies to finance documents when analyzing sales performance.

How to Make a Pivot Table in Google Sheets:

e Choose the Data: Your data will need to be available as a table with unique column headers.

e Click the Insert Tab: Now, you need to click into Excel and locate the Insert tab which is spread
out through the ribbon section in top of your screen.

e Choose PivotTable: Click PivotTable in Tables group in the ribbon.

e Select the Data Range — You’ll be prompted by Excel to select the data range that you’d like to
analyze. Choose the worksheet range or table, or named range that you want to use.

Step 2: * Select the Location: You have now created a pivot table, at this point you get to decide
whether you want to place it on a new work sheet or an existing one.

e Click OK: Once you have selected the range and placement area, simply click OK to enable pivot
table option.

e Assemble your own Pivot Table: A new dialogue is displayed, giving you the ability to drag fields
from each area of your database into a Section (as in Rows, Columns, Values and Filters). Future
Now you might want to start your summarizing and analysis.

Pivot Table Components:

e Rows: In a Pivot table, the rows are the analysis categories that you want to explore (for instance
products along with regions).

e Columns: Where the data points that requires comparison between various units (e.g.) Months or
Years are being placed.

e Values - You need to be able to take an aggregate over your selected data points (e.g. sum of sales,
average revenue).

e Filters: Tool based filtering of data help you focus on certain sub sets categories like product types
and date ranges.

Importance in Data Analysis:
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Through pivot tables, people can work with large data sets more efficiently because they get a clear
view of their data. This will allow you to successfully analyze big data sets and present the important
insights reporting to your clients. It enables users to:

o Create fast summaries.

e The procedure will give you the capacity to perform complicated Calculations on numbers with
ease.

e Support comparing with kinds of data types and time periods.

Power Pivot:

Power Pivot With its outstanding Excel add-in, Power Pivot provides users with the tools for all
kinds of data processing on huge amounts of data. The versatile data model of Power Pivot extends
to the capabilities of standard pivot tables, enabling users to work with large data sets, in high
velocity or variety or granularity and build informative reports.

Power Pivot allows you to handle multiple sources of data, and interpret the information featuring
complicated relations that depict in the old data model. But if you are dealing a lot of table data or
the kind of horsepower that comes from its many calculation options, there is reason to know about
and use this tool.

Key Features of Power Pivot:

Data Modelling: Power Pivot has a data modelling feature which let users make relationships
between multiple databases and adds sources of data such as sales information that could be
connected with customer information, then to inventory and so on. With Power Pivot, you can
perform advanced data analysis: Multiple tables are added to the model and it avoids those damnable
formulas.

e Big Data: Power Pivot can handle big data with over 1,048,576 rows of data that would be
impossible to do in Excel. The code adopts in-memory data model for reducing computational
amount over huge data.

e Data Integration: Excel Power Pivot capitalizes on its multiple data source extracting skills like
databases SQL Server, cloud services Microsoft Azure or Web data. The system combines all kind
of data in a designed way to form one big pile that can be counted and analyzed.

Advanced Computations Power Pivot, performs Data Analysis Expressions (DAX) on the fly
supplying users with the capability to define complex calculations using formulas that are difficult
for typical end users to create. In comparison to DAX functions advanced analytical capabilities,
regular Excel formulas would have very little options for analysis which enrich the analyses

possibilities in such complex situation.
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» Hierarchies: This allows users to organize and populate a data model hierarchically (such as
Year>Quarter>Month>Day) so that they can analyze general information before drilling down into
detail at various levels of granularity.

e PivotTables with -Charts: When awarding on aggregated data models whose data sources are
Power Pivots, enabling a user friendly way to make findings come alive.

Steps to Enable Power Pivot:

e [f you need to open you Excel, it will be in the File Tab.

® The Add-Ins is the menu options, they can click on it.

e You will receive a Message Dialog when you click COM Add-ins in the Manage dropdown. Then
click Go.

Power Pivot for Excel is automatically installed when you chose that option in Add-Ins, made
available by clicking on the "Microsoft PowerPivot for Excel" checkbox there and pressing OK.

e Once you activated the Power Pivot a new ribbon tab would be shown like below. Benefits of
Using Power Pivot:

e Processing much faster and more efficient: Because Power Pivot processes large set of data in
memory mode, the speed at which database process increase substantially. It takes the speed that
big-data people like business intelligence and financial analysts depend on.

e Powerful Data Models: Users are able to create powerful data models across multiple tables. The
use of data models for analysis is more complicated due to the fact that they accommodate complex
relationships between multiple sets of data points in addition if any, such as one-to-many or many-
to-many.

Advanced Analytics: More advanced calculation beyond the power of Excel's native capabilities is
at your fingertips as PowerPivot and its Data Analysis Expressions language provide you the power
to define custom calculations and intelligent time line analysis. That kind of feature is only useful
for business analysts or data scientists doing predictive modeling or some other type of advanced

analytics.”

File Home Insert Page Layout Formulas Data Review Wiew Help Power Pivot
5 g R of
Measures  KPls Add to Detect Settings
= = Data Model
Data Model Calculations Tables Relationships

Fig 1.31 Power Pivot

Formula Auditing Tools:
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You can quickly and efficiently analyze formulas in worksheets to ensure they are used
appropriately with Formula Auditing Tools. During data analysis, the analytical tools can be used
to identify errors or inconsistencies in formulas and improve the trustworthiness of the data being
analyzed.

You can use formula auditing to follow data movement across sheets - that is, when you're trying to
verify your formulas are right and see if any errors are occurring. Best in big workbooks with many
formulas based on multiple references The tools perform best in large workbooks containing a large
number of formulas that rely on multiple references.

Top Features of the Formula Auditing Tools:

e Trace Precedents - An option that allows users to see all activity referenced in every formula. The
tool highlights the data cells that serve as formula instructions (or what are called precedents) to
illustrate how changes in cells spread by reference throughout the worksheet.

e Trace Dependents: It is an overview of all cells that the selected cell receives data from. What the
tool does is to show you how changes in value in one cell ripple out across various areas of the
worksheet.

e Error Checking: Excel’s feature, Error Checking automatically evaluates worksheets in order to
find errors that would arise in formulas. Excel's Error Checking feature can identify divide-by-zero
errors and also find reference errors including circular references, then suggest how to fix them.

e Show Formulas: With the Press of a button your spreadsheet displays the formulas being used to
calculate formulas, as opposed to showing you the Result that everyone else sees. You can see what
formulas you’re using in your big spreadsheets by having this tool show all active formulas. Results
browse is still possible through a toggleable interface.

e Evaluate Formula : Begin by reviewing this feature to see how Excel calculates across each
element of formulas during calculation step-by-step. The program identifies erroneous calculations
locations, especially on complex formulas of several levels.

e Circular References: Excel warns users about ‘circular references' when a calculation refers to
itself directly or indirectly, possibly leading to an infinite loop of calculations. Such problems can
be found and corrected more easily with the formula auditing tools.

How to use the Formula Auditing Tools:

e Enable the Formula Auditing Toolbar: Go to the Ribbon at the Formulas tab.

e Trace Precedents: Select the cell containing the evaluative formula you want to trace. From the
toolbar, select Trace Precedents in the Formula Auditing group. The cells you refer to from your

formula are created as visual indicators which are indicated by arrows pointing to said cells.
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e Trace Dependents: To trace dependent cells, first select an area and then use the Trace Dependents
command. You can also see these arrows in Excel, when the one column cell is selected then there
are arrows that signify which cells are dependant on it based on their values.

e Show Formulas: Use the Show Formulas button to display formulas instead of the results in the
cells on your sheet. Reviewing big spreadsheets is easier if Show Formulas shows formulas (instead
of their results) in several cells at the same time.

e Evaluate Formula: Choose the cell containing the formula you want to check. Begin evaluating
the formula with Evaluate Formula, and watch the series of calculations unfold.

e Error Checking: This button launches a Run an Error Checking process on your morksheet. The
app shows mistakes in your sheet and recommendations to correct them.

Benefits of Formula Auditing Tools:

e Error Recognition: Formula auditing options enable users to quickly and easily identify errors in
their spreadsheets, such as broken references and incorrect formulas, as well as display logical
faults. Such tools are especially useful for people who have to audit giant formulas or large sets of
data.

e Data Transparency: Precedent & dependent tracking allows these tools to display the spreadsheet-
wide data flow. Your ability to source information and then use it is tracked better across your docs.
® Troublesome Formulas: With so many cells and functions, we almost always run into issues with
an overly complex formula organization-wide. You can simplify your troubleshooting by breaking
the formula in parts using Evaluate Formula feature with step-by-step checks that help you identify
where it fails.

e Efficiency: They are more efficient by automatically verifying systems that can be used to detect
potential problems instead of manual verification against large datasets.

e Enhanced Accuracy: Formula auditing provides accurate formula validation which prevents
companies from making errors in their analysis. Formulas Formulae that are dedicated to robust
models of decision and financial statements, as well as studies, use correct calculations.

Steps to use:

Go to the Formulas tab and choose Formula Auditing from the menu.

The device detects mismatched data items for correct reporting of data.

@ autosave Book1 - Excel £ search

File Home |Insert Page layout Formulas Data Review View Help

f\ Z @ @ CID & Define Name ~ ~ EL, Trace Precedents W Show Formulas

[ =
Y i .y
Insert AutoSum Recently Financial Logical Text Date & Lookup & Math & More Name B Trace Dependents ¥ Eror Checking

Function v Used v v v ¥ Time > Reference v Trigv Functions¥  Manager BZ Create from Selection F’, Remove Arrows v (%) Evaluate Formula Window

Function Library Defined Names Formula Auditing

Fig 1.32 Formula Auditing Tools
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Knowledge Check 2

State True or False:

Excel can import data from CSV and excel only — you are unable to import directly from Database
or Online.

Power Query enables users to automatically import, cleanse, and transform data from a diverse
range of sources.

Web Data Import in Excel allows you to get real-time live data, like online stock or weather
information.

In Excel, you would use pivot tables mainly to format text and apply font.

Clever Ideas How to Identify Trends in Excel - Goodly a user What is conditional formatting?

1.4 Key Functionalities of Excel for Data Analysis

Excel provides an array of capabilities which allow you to use mathematical and classification
methods, and build decision models that provide users with business insights into operations. Users
have a complete suite of features and functionalities in Excel With built-in, only it helps users to
process data efficiently. Excel's default mathematical and statistical functions help the users to
analyze their data effectively.

Basic Statistical Functions:

Common functions include:

e =AVERAGE(range) — This formula gives us the average of a range.

e =MEDIAN(range) — Returns the median value.

e You then use the MODE function to determine which number occurs most frequently in the
range.

e =STDEV(range) — This calculates the standard deviation.
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B11 ¥. > v I =MEDIAN(B2:B10

| A g0 ¢ | b | E ¢
1 |Textbooks Quantity Cost Discount Revenue
2 EMaths 321 250 20% 16050
3 _English 500 180 72000
4 EHindi 200 120 18000
5 EPh\.'sics 620 420 40% 133080
6 _Chemistrv 500 300 10% 13500
7 EBir::!log\,f 300 128 5% 9500
8 |Accounts 200 200 20% 16050
9 |Economics 180 250 50% 1015000
10 |Sociology 150 120 15% 5760
11 | ~MEDIAN(B2:B1( 16050
12 | MEDIAN(numberf, [number], ..}
13

Fig 1.33 Basic Statistical Function

The instrument offers an efficient manner to describe the data and find patterns in its sample
distribution.

Data Analysis ToolPak:

datanamic Data Analysis ToolPak is an easy-to-use add-in for Microsoft Excel. The functions in the
Data Analysis ToolPak including correlation and regression testing are available along with
summary statistics and many others. A splendid bonus pack for those who would like to perform
advanced statistical work in the cool playground of their comfy Excel.

4 FinishingtheDataAnalysis ToolPak]init Features:

e Regression Analyze: You can use the third key to analyze regression, you can carry out automated
fitting of curves between the dependent and independent variables with linear regression. This, as
well as the prediction analysis between vehicle and host RNAseq dataset are common to this
function.

e Correlation- To test and see the relation of two or more things where how each component affects
the other, it tests them in a way which even helps you identify some common patterns on your data.
e Descriptive Stats: Important type of descriptive statistics are readily available in the app

-- summary stats such as mean, median, mode, but also variance and standard deviation. This
understanding simplifies certain basic properties of data sets.

e ANOVA (Analysis of Variance): For detecting the statistical difference, if any, between the means
of different groups.

e t-Test: User will be asked to input differences between mean of samples and then identify whether

differences are significant.
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e Plot: with this feature, the user can easily draw histograms for distribution and charting intervals.

e F-test: It is used to testify for the statistical difference between population variances this helps in

testing dissimilar groups of data.

B New
= Open

|2 Share

Get Add-ins

Info

Save

G)
@ Home v New

Good

Fig 1.34 Data Analysis ToolPak

This is where this plugin excels in the statistical details.

Lookup Functions (VLOOKUP, HLOOKUP, XLOOKUP): Reference functions designed to

retrieve information from huge data incursions with reference of specific lookup criterion.

Usage: =VLOOKUP(value, table, col index, [range lookup])

SUM - X « & =VLOOKUP(H2,B3:E12
A I B C | VLOOKUP(lookup_value, table_array, col_index_num, [range_lockup]) ‘
1
|k | Employee ID ~ Name Department  Salary _J Employee IDI 19006
3 {19001 Anne Logistics ~ $4,000 | Salary  |12,B3:E12 |
4 ? 19002 Mia Logistics $3,500 E
5 { 19003 Tony Sales $5,000 |
6 [ 19004 Jason Sales $5,000 |
7 {19005 Brenda Sales $4,800 |
8 | 19006 Jean Marketing ~ $4,500 |
9 ; 19007 Belle Marketing $3,500 E
10 i 19008 Ema Logistics ~ $3,000 ¢
11 {19009 Jim Marketing ~ $3,700 |
12 | 19010  Terry _ Marketing $3,800 |
13 {10R x 4C |

Fig 1.35 Lookup Functions

They are used to locate business details from the company databases. Logical Functions (IF, AND,

OR):

The logic testing will lead to conditionally applied actions.
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[I: logical_test, [value_if_true], [value_if_false]) ]

Fig 1.36 Logical Functions

Examples:

=IF(A2>100, "High", "Low")

The classification and segmentation of data takes place through business rule allowances.

1.4.1 Data Visualization

The data is visualized in a comprehensive graphic representation with combined charts and
graphs/diagrams. With the plethora of visualization types available in Excel, the user is able to create
visual representations for data that are easy to comprehend and can make sense at a glance. There
are tools to support wrangling raw data into analytic narratives that makes complex information
more immediate to readers.

Charts (Bar, Line, Pie, Column):

e Column and Bar Charts: This chart helps you to present data across multiple categories in visual
form. Graphical design that is friendly to eye and user’s thoughts make the difference or pattern pop
everywhere brings great convenience for using voice code.

e Line & Area Charts: A visual aid that best illustrates changes in figures over time (e.g. sales across
months).

e Pie chart: It can show the proportions of a total value; for example, we use pie charts to represent
the percentage composition of market share or budget.

Scatter Plots: These graphs are useful for helping us see relationships between two variables and for

detecting correlations.
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A B e D E E G H J
1 &
3 1 1-Jan-24 PK 62
4 2-Jan-24 Sara 67
5 Top 4 Employees by Sales 2-Jan-24 Willam 82
6 900 o 2Jan-24 Ravi 2
7 800 2-Jan-24 Lucy a
s 700 3-Jan-24 PK 38
3 | eo0 s _ 4lan-24 Jack 64
10 2932 4-Jan-24 Sara a7
11 Soe 7-Jan-24 Lucy 63
12| | W0 8-Jan-24 Ravi 54
13 300 8-Jan-24 Jack 51
14 200 8-Jan-24 Lucy 88
15 100 8-Jan-24 Jack 87
16 5 9-jan-24 PK &9
17 ok Lucy PK Ravi 9-Jan-24 Lucy 68
18 10-Jan-24 Jack 61
19 11-Jan-24 Lucy 55
20 11-Jan-24 William %
21 12-Jan-24 Jack 39
22 12-Jan-24 William 34
23 12-Jan-24 Lucy 56
.
Fig 1.37 Charts

Steps to create:

On your Excel screen click on Insert tab, under the Charts group.

Submission ID trn:oid:::3618:127056669

Helpful also for reporting and analysis in the finance department as well as sales performance.

PivotTables and PivotCharts: The feature uses big database data to weave sections around element

types in order to analyze them.
Steps to create:
Move to Insert > PivotTable.

Perfect for business performance reviews and KPI tracking.

B  Autosave v Book1 -
File Home Insert Page Layout Formulas
= o= l_(‘)Shapes"
id | 17 B &0
PivotTable| Recommended Table Pictures < Icons
v PivotTables ¥ €D 3D Modg
E From Table/Range Iy
N ['é From External Data Source
D E
15
2

Fig 1.38 PivotTable

Sparklines - do in-cell charts to show trends inside your table.

Steps to apply:
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o AutoSave @ oFF () 1] @ -~ i sales Data
Home Insert Draw  Page Layout Formulas Data Review View Developer Q) Tell me
v L o=
B B O P T Ea@. o
@ O o Xeo v T Q 0m
Tables Data from lllustrations Add-ins Recommended @ © |_ & D.‘JE v Maps PivotChart Sparklines
Picture Charts =
Data From Picture Charts Sparklines
B6 - fx 5000
A B Cc D Ef B G H J K L M
1
2 Circa Company
3 Northeastem Quarterly Sales Report
4
5  Location Qtr1 Qtr2 Qtr3 Qtr4 Total
6 | Connecticut $ 5,000 | $1,000 | $2,500 | $ 3,500 |$ 12,000
7 | Maine $ 1,700 $1,900 $2,800 $ 5,100 | $ 11,500
8 | New Hampshire | $ 2,100 $2,300 $2,800 $ 5,400 | $ 12,600
9 |_Vemont $ 950 | $2,050 $1,850 |$ 3,150 1§ 8,000
10 _Quarter Total $ 9750 $7,250 $9.950 $17,150 $44,100
11
1
. .
Fig 1.39 Sparklines

Users can view trends that develop over a span.

What-If Analysis (Goal Seek, Scenario Manager):

What-If Analysis is one of Excel’s most powerful features and this what-if analysis tool allows a
user to analyse possible outcomes with a variety of inputs. This enables users to discover how
changes in environmental conditions may affect the quality of their data, and make fact-based
decisions. The application of this model provides a valuable techniques in the field financial
prediction and decision making under various scenarios.

Steps to use:

Steps to Use What-If Analysis:

Go to the Data tab in Excel.

From the list of tools, click What-If Analysis.

Select one of several options, including Goal Seek or Scenario Manager, depending on your analysis
requirements.

e Goal Seek: Aiding in determining the input variable value for the desired result of a formula. For
instance, it can be used to calculate how much a company needs to sell in order to reach a target
profit.

e Scenario Manager: Enables a user to create and then compare among multiple sets of input values
(scenarios) in order to discover their impact on the result. For instance, the best-, worst- and most-

likely business cases could be compared.

@ auosave (@ off) =

Book1 - Excel £ Search

File Home Insert Pagelayout Formulas Data Review View Help

wus [ Queries & Connections | [ZTA] =g # = o @ T T
(& [3 L [ B 2 EB R 5 B G 8B 3
Get  From From From Table/ Recent Existing Refresh z| Sot Filter Textto Flash Remove Data  Consolidate Dat What-If Fofecast
Datav Text/CSV Web  Range Sources Connections Al v & S8 Advanced  Columns Fill  Duplicates Validation v Mode|~  Analysisv gheet

Get & Transform Data

Queries & Connections

Sort & Filter

Data Tools

Forecas
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Fig 1.40 What-If Analysis

Activity: Excel Data analysis and visualization

Objectives: Data analysis, statistical functions and visualization using Excel.

Steps:

Use Statistical Functions: Apply AVERAGE(), MEDIAN() and STDEV() to study the performance
of sales over time.

Use Data Analyst ToolPak: Regression and Histogram on sales data.

Lookup & Logical Functions: Find sales information with VLOOKUP() and categorize revenue
using IF().

Make Charts & Sparklines: Build a Column, Line or Pie Chart plus add trend-lines.

What-If Analysis: Goal Seek to determine sales necessary to reach desired revenue and Scenario
Manager tool can be uses to evaluate pricing strategies.

Reflection:

What did you learn from statistical functions and charts?

How did What-If Analysis aide in decision making?

Deliverable: A summary or screenshots of what you found.

Investors analyze stock market data with the aid of Excel's analytics tools, and in return they gain
invaluable information that further spurs their investment decisions with data. Excel-embedded tolls

allow trend analysis and portfolio analysis along with forecasting tools.

1.5 Summary

% % As one of earliest systems with user friendly GUI and strong analytical capacity, Excel has
played a pivotal role in business decision making based on data analytic techniques.

date dec to enable further analysis.

Excel-based database retrieval as an analytical package.

your information and whatever decisions can be done as nicely.

of actions with which to analyze the business.

arranging and analyzing data to learn more productive business plans.

1.6 Key Terms

Once you know the trends about What is Business Analytics Structured Data, you make better
business decisions about it, and then you find out much more additional pattern and some nuggets

with insight levels. Data Types : Excel can process many data types starting from number values
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and, along with text strings, dates, and Boolean values. Data formats : Data is success = Number
category organization with currency/date and text formats that making the calculations proper
refreshing the data view. Import: Excel permits you to import external data from database; CSV files
and web applications. PivotTable: Excel fans from all over the place have been turning information
into actionable, incredible finished products for decades alongside analytical paragons. Cleaning in
Practice: The analytical truth of data refers to as accuracy-patches algorithms that detection- errors
and repair-processes can give up. Power Query is a feature in Excel that merges data from diverse
sources with transformation steps and data merging techniques. Data Visualization : A visualization
tool with tables and graphical charts of displaying data in an efficient way of presentation format.
Statistical Functions: use AVERAGE, MEDIAN and STDEV built-in function in Excel for analyzing
the statistics of your data.

1.7 Descriptive Questions

Explain how Excel is defining the importance of business analytics and why it's considered to be a
vital in any industry. How is Excel a fundamental tool for data analysis and still an essential
application in business?

Power Query & Data Formatting combine to keep the data quality bar high. Why do we need to
finish this data prep work before we analyze anything? How does cleaning data with Excel help to
ensure the results were reliable and accurate during analysis?

Learn how businesses should act for adopting PivotTables over Excel when we analyse. What
variety of datasets are suitable for consolidation into PivotTables and how would this tool
complement various aspects of business?

What is Data Visualization, and How Does It Apply to Excel? Explain how the charting tools in
Excel can be used to present data visually and provide an example of what valuable information one
may glean from visuals.

What is excel statistical function and how business users can use it for making their data analysis
better? Describe what functions such as AVERAGE, MEDIAN, and STDEV are for—even if you're
not using Excel-—and how they assist in analyzing trends and arriving at data-informed decisions.
The predictive power of Excel ensures better planning in future for retail business and health sector.
In Excel, as a businessperson, what tools and approach can be utilized to predict the future trend?
Analyzing data via Excel has theungoing positive efects on your strategic decisions as well as
tactical succecess. What are the stages of data analysis that help organizations to take right

decisions?
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Discuss in what ways the case study in this unit demonstrates the use of Excel as a tool to assist with
problem solving. What were the key insights that you gained from your case study analysis and how

would you apply it in solving specific business challenges by using Excel?
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Answers to Knowledge Check

Knowledge Check 1

Boolean (Logical) 2. Home 3. Dates 4. Conditional Formatting

Font

Knowledge Check 2

False 2. True 3. True 4. False 5. True

1.9 Case Study

Covid 19 analysis

The Covid-19 pandemic generated an international health crisis that required fast decision-making
based on data. Laws need to be in line with how the virus spread and research institutions and
healthcare providers must examine recovery indicators for scaling up essential health interventions.
This was only made possible through Excel’s built-in data analysis tools that allow statistical
analysis and data visualization (trending) techniques as well as used in decision making.
Introduction:

Excel’s powerful tools helped healthcare and policy leaders analyze huge amounts of WHO and

Johns Hopkins data from around the globe. Excel application was primary weapon to control Covid-
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19 data through cleansing functions and analysis options as well as data visualization techniques to
reveal actionable insights for anti-pandemic measures.

Statement of the Problem: The raw data collected throughout Covid-19 was huge and often messy,
featuring issues such as:

e Duplicated instances in data sets

e Data which is not completed or missing

e Inconsistent date and figure types SELECT subnational indicator country code,iso year month,
value from bq-results-20191007-135511-jr7iohbjzhw?2 Page 5;9 February Findings on the Worst
Forms of Child Labor:https://www.dol + gov/agencies/ilab/resources/reports/child-

labor/findingsAccessed 29 Sep ; BLS-SOR (n/d) New York State Department of Labour - Subject

of Record Files[atsdr.cdc.gov/toxprofiles/index.asp] U.S Environmental Protection Agency
[www.epa.gov]World Bank development indicators ISBN International Statistical Institute
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You can’t make important decision like this one without having clean and well-structured data: bad
conclusions will follow. It was essential to calculate and process the data appropriately in order to
identify trends in infection, recovery, or both and overall effectiveness of public health
interventions.

Solution

Data Cleaning and Aggregation: We initiated our process with daily updates of such resolved cases
(confirmed cases+recoveries, as well as deaths) from official reports. Data was cleaned and
transformed to adjust for or into:

Removing Duplicates:Duplicacy of Meeting repetition records were removed by using "Remove
Duplicates" option in Microsoft Excel.

Handling of Missing Data: In the absence of data points,the IF ERROR function would choose
between estimated values and mean-imputed values hypothetically.

Normalization: We did normalize the data where numbers and date was there in the dataset using

Excel formulas as TEXT() and VALUE().
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EDA on Excel: Once the data was clean, we used Excel’s powerful analysis features to discover
some interesting trends such as :

Pivot Tables: The Pivot Table was used to analyze confirmed COVID-19 cases across multiple
regions and different time periods. The site enabled both an inter-regional comparison and
identification of trends in infection rates.

Charts and Graphs:One line graph showed the evolution of cases over time. Pie charts were used to
present percent of recovered patients with active case trends.

Descriptive statistics: mean, median and standard deviation were used to summarize trends in cases
as well as describe how the data points varied.

Key Insights: Some key insights were derived from the analysis of the data

Trend analysis of infection within the community: This identified “outbreak trends” which were
acted upon immediately by healthcare workers.

Regional Recovery Rates: The recovered rates that presented a different pattern in each region are
useful information to support developing healthcare-focused intervention policies within limited
regions.

Effectiveness of lockdown: The evidence looked at the effectiveness of lockdown so that
governments could see what had worked best to slow transmission of COVID-19.

Conclusion: Using Excel tools such as data cleansing and analysis with visualization, many policy-
makers and healthcare professions made decisions, during the pandemic caused by Covid-19
grounded in the data. The information we used to generate our projections was the one that not only
enriched us with knowledge of how disease could be transmitted as it is, but hinted for an appropriatte
use of resources and set up intricate interventions aimed to mitigate virus spread. Through the
pandemic Excel was an essential, performing as designed to support creation of vital data analytics

informing how public health imperative decision-making process could be carried out in real time.
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Unit 2: Essential Excel Functions

Learning Outcomes

1. Learners will be able to identify and apply essential Excel functions for data analysis in business
scenarios.

2. Learners will understand and utilize text, arithmetic, time, and date functions to manipulate and
analyze data effectively.

3. Learners will demonstrate proficiency in using absolute referencing to enhance formula accuracy
and efficiency.

4. Learners will apply Excel functions to solve real-world business problems and improve decision-

making.

Content

2.0 Introductory Caselet

2.1 Introduction to Essential Excel Functions
2.2 Basic Excel Functions for Analysis
2.3 Text Functions in Excel

2.4 Arithmetic and Statistical Functions
2.5 Time and Date Functions

2.6 Understanding Absolute Referencing
2.7 Summary

2.8 Key Terms

2.9 Descriptive Questions

2.10  References

2.11 Case Study

2.0 Introductory Caselet

Learning and mastering Excel's core functions are critical to succeeding with data analysis.

Arjun is a data analyst at a logistics company and he’s been working there for over 3 years. He has been assigned to an
analysis of delivery performance by area. He comes up with an Excel dataset from his manager which contains:

- Order Date

- Delivery Date
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- Customer Name
Arrival State (On-time, Delayed)
- Product Category
- Total Shipping Cost
Arjun quickly realizes that he needs to clean and analyze the data before drawing conclusions. But he doesn’t know
how to properly handle missing dates, categorize latenesses or calculate KPIs.
- To fix the problem, he needs to acquire some essential Excel functions:
- Basic operations (SUM, AVERAGE) for calculation of total delivery costs and average costs.
Text Functions (TEXT, LEFT, RIGHT) to extract certain details from order numbers.
- Math & Stats (COUNTIF, IF, MEDIAN) to sum masses of delayed shipments and analyze costs over time.
Date Functions (DATEDIF, NETWORKDAYS) to calculate rate of delivery.
Absolute Referencing to ensure correct calculations on various cells.
While doing so, Arjun notices a trend — deliveries from one of the warehouses are being delayed with alarming
frequency. His insights will help the company to optimize its logistics efforts, and now he has to figure out how to

communicate his findings to his manager.

Critical Thinking Question:
What are the approaches that Arjun can use Excel functions to find and address the reasons for repeated disruption in
deliveries? Suggest two or more excel tools or functionality through which he can analyze and improve delivery

efficiency.

2.1 Introduction to Essential Excel Functions

Business and analytics decisions rely much on Microsoft Excel as a key support tool. Businesses in various trades rely
on Excel for both their sales trend analysis and financial data compiling and operational optimizing and productivity
improvements. They prefer to utilize Excel built-in functions that can help them do the complex calculations in an
automatic way which provide less errors and more efficiency at work.

The significance and application in real life of Excel is determined so that you can see the use of various functions from

different categories which are likely to come in use across multiple business scenarios.
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Goals Level Balance Value($)  Balance sheet Resources Balance Value($) B a | ance s h e e-l-
Major Goal Level 1732577 W Futare Benefits 2,568,790
Office aiiig 280,282 - -5:000,000 Jenifer-Social security 976,819
Long team care 856,740 Jonathan-Social security 869,870
Retirement bonus 121,210 4,500,000 CUPT Sevices co, td—amuity 121,000
Bonus = 399,345 GT Group — Pension 421,045 ~5.000,000
Other goals 75,000 000,000 TAUQO co, lid~Bonus 179,984
Torget Goal Level 2,568,790 B futare Sovings 690,144 4,500,000
Office outing 263,819 3,500,000 Sale of 3 second car 279,991
Long team care 776,208 ge“f'g'?"’“"is . 233;22
Refirement bonus 179,984 ontribuition-Jonathan .
Bonus 421,045 a/Ra0;000 Reward 75,380 4,000,000
Other goals [} 86,230 2,500,000 [ ] :mkgm:e(aanm:coms g;gg;z
amily brokerage Acct 1689
Aspirational Goal Level 4,689,154 Jenifer individual savings 563,980 3,500:000
Office outing 1,829,450 2,000,000 Savings account 45,000
Long team care 980,750
Retirement bonus 368,970 1,500,000 Retirement Account 461,771 3,000,000
i S Jenifer-bonus 182,790
Other goals 559,984 o - o
1,000,000 onathan-Conribution » N—
Total Goals L] 4,689,154 Total Resources 4,567,284 R
500,000
Total Funding Dificit 121,470
% 2,000,000
oals Level Resources
1,500,000
Funding percent by Goal Level
Gouls level Godls cost Total resources Surplus,/Deficit Funding 1.000.000
Major level 1782577 4,567,284 Surplus : 2,834,707 Funding
Torget level 2,568,790 4,567,284 Surplus : 1,998,494 Funding | 500.000
Aspirational level 4,689,154 4,567,284 Deficit 121,470 Funding
***This tabel is showing the percentage of Resources that are available to fund the cost section of each Goal level Goals Level Resources

Fig 2.1 Budget Tracking in Excel

The Importance of Excel in Business Analytics and Decision Making

Businesses are able to get very effective data processing and analysis thanks to the heavy reliance on Excel
software by business organizations. Some key benefits include:

e The software also structs data and accommodate organized systems on which formulas can be formulated
creating a useful knowledge.

e Excel based applications will eliminate time required for automatic repetitive operations and the potential
human error.

e Practically all enterprises use Excel for creating financial models and running risk analysis scenarios while
making strategic decisions.

e We have an in house performance monitoring tool built on Excel using dashboards and pivot tables to
monitor the KPIs of the organization.

There are plenty of real world Excel functions in use that benefit all sorts of industries.
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Financial Analysis and
Budgeting

7 Sales and Marketing Analytics

Excel

Applications in
Business

Human Resources and
Workforce Management

Operational Efficiency and
Decision-Making

Financial Analysis and Budgeting

Financial analysis is one of its key components and an important source for business decision making. With functions

in Excel built specifically to simplify and automate financial accounting. Organizations are able to calculate their

profits, make budgeting estimations, and even measure the level of business sustainability.

E.g: The report totals are calculated by SUM()s across multiple geographic areas while AVERAGE() are used to surface

the average monthly spend at this firm.

2 () () (®)

112 v i Jfx
[ A B (€ D
1
Q1 Q2 Q3 Q4
Region Revenue Revenue Revenue Revenue

Karnataka  15,00,000 18,50,000 16,00,000 17,50,000

16,00,000, 17,50,000) = 67,00,000 =67,00,000/12 =
3 5,58,333.33
4 |Maharashtra 20,00,000 22,00,000 21,50,000 23,00,000 86,50,000 7,21,666.67
5 Tamil Nadu  13,50,000 14,00,000 15,00,000 16,50,000 59,00,000 4,91,666.67
6 Gujarat 11,00,000 12,50,000 13,00,000 14,00,000 50,50,000 4,20,833.33
7 |Rajasthan 9,00,000 9,50,000 10,00,000 11,50,000 40,00,000 3,33,333.33
8

Monthly Avg

Total Revenue (%) s}

=SUM(15,00,000, 18,50,000,

Here,

Fig 2.3 Regional Sales and Expenses Data

Total Revenue (%): Summarize total revenue over all quarterly This section performs a summary of the Totat Revenue

of all quarters.

Example (Karnataka):

=SUM(15,00,000, 18,50,000, 16,00,000, 17,50,000)
Total Revenue =367,00,000

Monthly Average Revenue (): Total revenue must be divided by 12 in case you work for twelve months.
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Example (Karnataka):

67,00,000 ~ 12 =%5,58,333.33

It is Karnataka’s monthly average revenue through this figure.

Application:

» Automobile Industry (Tata Motors, Mahindra & Mahindra): SUM() and AVERAGE() functions help these companies
control their quarterly sales of vehicles in various regions and observe its operational expenses on factory and showroom
properties across different states.

» Consumer Goods (such as Hindustan Unilever, Dabur): In such company SUM() is used to add up sales information
across different states of a country and then AVERAGE() to calculate monthly costs for logistics and production.
Sales and Marketing Analytics

Numerals function used by salesmen and direct marketers (e.g. to revolutionizing purchase order or measuring
marketing programs as well as constructing consumer data dimensions).

Example: The COUNTIF() feature of an e-commerce business will serve to find out distribution order quantities at
different geolocations its customers.

Example Use Case: Order Volume Distribution Across Regions for an E-commerce Player

Use Case: Your e-commerce company wants to look at in-app purchases from customers in different parts of the
country. The business team should conduct this type of analysis to understand customer ordering patterns by location
and to inform supply chain optimizations.

Data: A list of several Order IDs with Customer Names and Regions (customer location information) exists in an Excel
sheet for the company.

All order data is displayed in the following format:

Oider 1D Customer - Order Amount
Name (X)
1001 A. Sharma Karnataka 2,500
1002 B. Gupta Maharashtra 3,000
1003 C. Reddy Karnataka 1,200
1004 D. Kumar Gujarat 4,000
1005 E. Patel Maharashtra 2,800
1006 F. lyer Rajasthan 1,500
1007 G. Mehta Gujarat 3,600
1008 H. Sharma Maharashtra 2,900
1009 I. Kaur Karnataka 3,200
1010 J. Singh Rajasthan 1,800

Fig 2.4 Order Quantity Distribution Across Regions

Using COUNTIF() Function to Figure Out the Order Quantity by Region:
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Goal:

This formula helps counting orders by the region-based customers.

COUNTIF() Function:

You can with COUNTIF() figure out how many of the cells in those ranges meet certain criteria.

For Karnataka:

To calculate the number of orders from Karnataka, you can use following formula in Excel:

=COUNTIF(C2:C11, "Karnataka")

This formula is counting the total cells that includes “Karnataka” from range C2:C11. 3 orders have been despatched
for Karnataka region in that calculation.

Human Resources and Workforce Management

Excel can be used by HR departments to maintain records for employees, monitor attendance and calculate employee
payments.

Example: A tech company monitors their employee tenure utilizing DATEDIF() functions for determining eligibility
for promotion.

Use Case Example: E-commerce Sales and Marketing Analytics

Sales Order Distribution with COUNTIF()

Organisation sales team need information about order quantity distribution across different geographies in their e-

commerce industry. By using COUNTIF() you can determine which areas have created orders for the company.

Did you Know?
Excel was first developed by Microsoft in 1985 for the MacOS, followed by a version for Windows in 1987. It soon
became one of the most popular programs in businesses past the easy to use card system was, a positive and productive

software tool that helped your business grow.

Data: The sales has a list of orders and associated customer regions. Table presents the Regional values along with the
Order Amount (%) figures and separates them in terms of Customer Name and, apart from that, Order ID. cs in an E-
commerce Business

Sales Order Distribution with COUNTIF()

Inan e-commerce organization, the sales team has to monitor the distribution of order quantity over geographic regions.
The COUNTIF() function used here to have a count of orders received from each region.

Data:

The sales department has a list of orders and the name of region in which the customer is located.
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. Order Amount
OrderID Customer Name Region ()

1001 A. Sharma Karnataka 2,500
1002 B. Gupta Maharashtra 3,000
1003 C. Reddy Karnataka 1,200
1004 D. Kumar Gujarat 4,000
1005 E. Patel Maharashtra 2,800
1006 F. lyer Rajasthan 1,500
1007 G. Mehta Gujarat 3,600
1008 H. Sharma Maharashtra 2,900
1009 |I. Kaur Karnataka 3,200
1010 J. Singh Rajasthan 1,800

Fig 2.5 Customer Orders list

2) Use COUNTIF() to Get Orders from Each Region:

Say, businesses can count the number of orders from Karnataka by using COUNTIF().

For Karnataka:

=COUNTIF(C2:C11, "Karnataka")

As aresult of this calculation, the output shows that there are 3 particular orders in Karnataka.

For some more regions you can use the same function to find some patterns of order distribution in different geo -
locations.

Some of the TEXT Functions to get Brand Information

The marketing 102 team has to extract brand data from product Stock Keeping Units before it can even kick start a
promotional foray. The brand itself is listed separately, with product type and model number also detailed on the inside
of the SKU (Stock Keeping Unit).

Let's say the SKU format is: BRAND-XXX-YY

Where:

e BRAND: The initial 5 letters of these 7-character skus are code for company brand.

® XXX: Product type code (not applicable for this use case).

® YY: Model number.
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Data:
SKU Product Name
APPLE-X12-05 iPhone 12
SAMSUNG-S45-08 Galaxy S45
NIKE-NK89-02 Air Max 89
SONY-5Z23-06 Bravia TV SZ23
LG-LG43-09 LG Refrigerator 43

Fig 2.6 Product Details

Apply the TEXT function in Excel to Extract the Brand Name:

LEFT() Function:

The LEFT() function subtracts the 5 letters from the SKU where is the brand name.

So in order to identify brand from APPLE-X12-05, the formula will be:

=LEFT(A2, 5)

We can utilize this function to obtain APPLE as the SKU from cell A2.

RIGHT() Function:

If the model number was a separate field, say at the end of a SKU, then we would use RIGHT().
For example, to match with APPLE-X12-05 the filter would be:

=RIGHT(A2, 2)

This will return 05.

MID() Function:

If we would like to split out some part of SKU (i.e. product code between brand and model), MID() function will work.
For instance, if you desire to pull X12 from APPLE-X12-05 then the formula is:

=MID(A2, 6, 3)

This will give the value of X12 (starting from 6th character & 3 characters).

How to Use These Functions in Marketing Campaigns:

The summary formulas can be leveraged by the Marketing Team for:

e Brand from product SKU extraction for product categorization for promotion goal.

e Promotional activities are carried out by marketing team according to the different brand designs.

e By examining SKU data, brands can be analayzed and turnover metrics and consideration measured by tallying how
many times the quantity or orders for a brand appear in order line items remembering to guard against double counting
with COUNTIF().

Operational Efficiency and Decision-Making
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Using Excel functions, operations and supply chain teams are empowered to make smarter decisions about resource
utilization and process optimization that drive stronger efficiency outcomes.

Example: With the use of IF() and VLOOKUP() functions the logistic company selects relevant suppliers by comparing
shipping times to best price options or stock availability.

Operational Efficiency and Organizational Decision-Making: Resource Utilization and process Optimization Needs
Excel Functions

Background: Operations are in the forefront to optimize resources given that management decisions and final results
leads to improved efficiency of Supply Chain function. Features such as the IF() function, VLOOKUP() and logical
and lookup functions in Excel assist businesses to examine data while working out the best solutions for their business
needs.

Sample Case: Logistic Company - Vendor Selection

A logistics provider must decide which supplier is optimal for transporting materials to locations in general. The
company needs to optimally consider the trade-off three dimensions of shipping time (lead time) as price and stock
availability. It is appropriate to compare suppliers in order to make this decision, and a basis for choosing the best
supplier (the one with the strongest recommendations) will emerge.

Data: The company’s supplier data has delivery times and amounts associated with different products and prices. The

company needs to evaluate these elements in order to select the best supplier.

Supplier Shipping Time Price per Unit Stock Best Price
Name (days) (%) Availability Option
SupplierA 5 150 Yes
SupplierB 3 170 No
SupplierC 7 130 Yes
SupplierD 4 140 Yes
SupplierE 6 160 Yes
Fig 2.7 Supplier Data

Using Excel Functions:

IF Function: What the company can do using IF() logicThe company takes conditional decisions based on which it
executes them. The company would need to check if any of its suppliers currently have stock on hand. The supplier is
added if they have stock and could be considered for further review.

A test with IF() functions can be used to determine if a supplier is able to make a delivery on given stock. Stock
Availability will be considered YES for a supplier to be eligible and the same becomes NO under any other state.
Formula Example:

=IF(D2="Yes", "Eligible", "Not Eligible")
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The IF function tests values in D2, Stock Availability from cell to cell and produces "Eligible" when stock is available
and "Not Eligible" when out of stock.

VLOOKUP() Function: Once the list of suppliers is narrowed, the company will compare time to ship and unit prices
between remaining candidates. Suppliers performance price per unit cost Searches their supplying within shipping time
and stock availability settings through VLOOKUP() 9.57/ responds This is a response that expresses the need of
suppliers to perform lookups on their unit costs against these settings along with timing factors.

The firm must decide upon an optimal transfer price for every shipping time in their analysis. We will use the
VLOOKUP() function to lookup for Price per Unit that corresponds to Shipping Time.

Formula Example:

=VLOOKUP(B2, A2:D6, 3, FALSE)

The formula is searching for Shipping Time (B2) in the first column of the table and returning Price per Unit from
column C.

Combining IF() and VLOOKUP(): A company can select which supplier is their best by using both the IF() formula
and VLOOKUP(). It consists of supplier eligibility confirmation and detail time-and-rate unit contrast to select the final
supplier.

Formula Example:

=IF(D2="Yes", VLOOKUP(B2, A2:D6, 3, FALSE), "No Stock")

The first test is whether the seller has existing stock. In this function VLOOKUP() returns price per unit against
shipping time for those suppliers who have stock. If No, it returns "No Stock".

Final Decision-Making Table:

And for example, once you know through IF() and VLOOKUP() what's the most convenient supplier (by product

availability stocks and price), then it can be like:

Supplier Shipping Time  Price per Unit Stock Best Price
Name (days) (%) Availability Option
SupplierA 5 150 Yes X150
SupplierB 3 170 No No Stock
SupplierC 7 130 Yes X130
SupplierD 4 140 Yes X140
SupplierE 6 160 Yes X160

Fig 2.8: Final Decision-Making Table using Supper Details
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It is up to the organization to choose a provider that gives the best price. This supplier (C) offers the cheapest price of

%130 and at the same time of product availability which becomes a better option for procurement.

2.1.1 Importance of Excel in business analytics and decision-making

In the modern business world, data-driven approaches have to be the basis of operation and not an afterthought in order
for organizations to remain agile. For business professionals, the primary weapon is Microsoft Excel that lets users take
charge of large amounts of data for the purpose of analysis and then visualize results to get ocular, swift decisions.
Excel brings multi-dimensional power that drives business forward with its powerful analysis and financial structure
modeling as well as its analytic insights to guide decision results. This chapter shows Excel’s necessity in various

business sectors using real-world scenarios.

Data Analysis & Visualization

Excel's ability to handle large data sets helps businesses find patterns, and the app can then take that information and
create charts and graphs. The system offers meaningful analytic data that leaders can use to improve decision-cutting.
Example: A retailer would like to analyze the sales performance across various geographic locations. Excel pivot tables
make sales data manageable - so companies can compare regional performance in a summary format, as well as easily
trend market trends. Bar or line type charts show the difference in regional performance data over time that allows users
to determine successful regions as well as under-leveraged ones.

Excel tools used:

e Pivot Tables to summarize data.

e Use of Bar charts, Line charts and Pie charts as graphical appliance.

Financial Modeling

Most hopes rely on Excel to set-up the financial models that provide crucial planning capabilities combined with
forecasting and analysis options. Several Excel functions allow companies to calculate future costs and revenue
projections with profit evaluations under various scenarios.

Example: A company uses Excel formulas like SUM(), AVERAGE() and IF() in budgeting and forecasting the next
fiscal year to create revenue models and cost structures. Organization staff are able to forecast sales in future by simple
forecasting of the sales data over past or complex models with market component and seasonality component. By
forecasting the company receives an estimate of profits and also information on dangers they have to face and growth
opportunities.

Excel tools used:

e Basic Math function such as SUM() and AVERAGE)() for financial calculations.

e The TREND() function and other forecasting tools assist users in predicting future value measurements.
Decision-Making Support

Excel since these contains abstruse aspects like What-If Analysis in conjunction with Scenario Manager that permit

companies to build scenarios and measure potential outcomes.
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Example: A company needs to make a choice regarding whether they should add new production equipment. Businesses
can create a number of operational models using Excel's What-If Analysis tool to analyses the costs and benefits that
they would incur in moving from an existing machine system to a new one. A systematic comparison of the ROI and
potential savings in operational costs and productivity gains would help to decide what is the best action.

Excel tools used:

e The analyser Whatlf Analysis allows analysis of different business scenarios by means of simulations.

e Scenario Manager to compare business scenarios.

Efficiency & Productivity

Excel is productive enough that the manual actions are programmed and efficiency is gained by repeating such
calculations. With faster calculations employees can spend their time on high value adding tasks.

Scenario Example: Marketing for a tech company is tasked with figuring out the cost of customer acquisition (CAC)
across different marketing campaigns. We were a little surprised when we started to use it as that marketing team just
used a simple Excel formula and the rest was done for them every time they have new data. The process helps avoid
errors and run more quickly, also offering employees efficiency in their jobs.

Excel tools used:

e Automation features can be utilized by professional users, enabling it to input formulas and built-in functions like
'SUM', 'AVERAGE!, or 'IF".

e Data Verification allows users to type in data correctly so data is accurate.

Businesses depend on Excel because of its ability to drive data-based decisions. Business processes call for efficiency
as well as learning and Excel provides for the automation of tons and man-loads of data, creation of financial models
growth scenarios for decision-making. This versatile tool is essential for all business domains, as it offers ease of use
as well as flexibility and in-depth functions. Companies that excel at Excel provide better decision-making tools and

gain competitive advantage in their market.

2.1.2 Overview of Key Function Categories

From the above, we can see that all the functions related to TRS in this paper can be divided into 4 categories:
traditional content based retreival (traditional CB Function), visual content based TRS function without
global features (NoG Function), visual content filter function with no global feature (F NoG Function) and

hybrid feature-based visual retrieval with and without Global signature image retrieval function.
Text Functions
Text functions help in the rendering, processing and analysis of textual material, such as names, addresses,

descriptions and/or other non numeric information. Business data has to be structured, scrubbed and

processed because so much of business is computer work.
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Common Text Functions:

e The CONCATENATE(): You can use it to join multiple text strings in one string.
Such as when you want to combine a first name and last name in a single cell.
Formula: =CONCATENATE("John", " ", "Doe")

Output: "John Doe"

e TEXT(): This will turn any number or date into text: it’s usually used to convert so that you can apply some

specific formatting (like currency or percentages).

For instance showing sales figures in currency form.

Formula: =TEXT(2500, "I#,##0")

Output: 22,500

o LEFT(): Returns a specified number of characters from the left side of a string.
Example: First three characters of product code.

Formula: =LEFT("ABC12345", 3)

Output: "ABC"

o RIGHT() :returns a set number characters ending from the right of the string.
Example: Extract the last 4 digits from a product code.

Formula: =RIGHT("ABC12345", 4)
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Output: "2345"

e MID(): Extract a substring from the middle of a string, using the initial and final position, with MID().
So for an example we can use the department code from “Finance-00123".

Formula: =MID("Finance-00123", 8, 3)

Output: "001"

e LEN(): Returns the length of a string (number of characters).

Example: How many characters are in the company name.

Formula: =LEN("Business Solutions")

Output: 17

e FIND(): It is a function to locate a substring in the given text string.

For example: We are in charge. Locate beginning of "Manager" in following sentence:
The formula is =FIND(“Manager”, “The Manager is in charge.”).

Output: 5

Arithmetic Functions

These can be arithmetic functions that you can use to perform simple math on numbers like add, average, etc.

They are needed for things like financial analysis, budget oversight and performance metrics.
Common Arithmetic Functions:
oSUM(): It is to Sum up all the numbers in a range, and it requires two arguments.
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Example: To find total sales of the month for various regions.

Formula: =SUM(1000, 1500, 2000, 1200)

Output: 5700

o AVERAGE(): Returns the average of a range of numbers.

For instance, calculate a score of customer rating based on survey scores.

Syntax =AVERAGE(4, 3, 5, 4, 2) Illustration The scores of a group of students in mechanical shaping are as
follows:  PlanScoreBearingTurningWelding  Machining4.43.54 Mean grade achieved MO05-B
(Average[(Withheld — Donitte) / Ommited] out of...

Output: 3.6

o MIN(): Returns the minimum value in a set of numbers.

Example: Explore the lowest inventory level in a Warehouse.

Formula: =MIN(120,200,150,80,210) Amount with in a defined range so that large numbers and small

number should be avoid.

Output: 80

e MAX(): Returns the maximum value in a set of numbers.
Example: Get the greatest income from different clear sale.
Formula: =MAX(5000, 7000, 4000, 8000)

Output: 8000
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e PRODUct(): Multiplies a range of numbers.

Example: To find how much money you get for 8 cans, calculate the price per can and multiply by number

of cans.

Formula: =PRODUCT(100, 25) (100 was sold at $25 each)

Output: 2500

e ROUND(): Rounds a number to the given valida of decimal places.

For Example:S 10.5Calculate the average revenue per unit to two decimal places

(ii1)unitsperRevenueAverage= S / Total RevenueUnites000S = SP S 00TM TM0020210.50RSPA!
Formula: =ROUND(12.4567, 2)
Output: 12.46

e [F(): Tests a condition, if it returns true one thing is returned, and if false another (the binary logic often

used to analyse financial results under different scenarios).
If we can be able to attain the sales target then we must return "Bonus" else we need to return "No Bonus".
Syntax =IF(SUM(1000,1200)>2000,"Bonus ","No Bonus ")

Output: "Bonus"

Activity: Business Analysis with Excel

Objective:

Find out how all of the features of Excel work together so that you can examine data, chart trends, and make sound
financial decisions.

Instructions:

Select a Dataset: Use an example sales dataset or create one, which includes product names, sales amounts, regions and

dates.
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Arrange Data in Excel
Input your dataset into an Excel table and use the element’s sorting or filtering functions to split sales by category,
region, or date.
- Conduct Data Analysis
- Perform Data Analysis
Employ Excel functions like:
The SUM() function to calculate total sales revenue.

AVERAGE() to calculate average revenue per product, or region.

2.2 Basic Excel Functions for Analysis
Microsoft Excel, often times, is the de-facto choice for a myriad of companies in the aspect of doing data analysis
within their business or finance-based applications. Let’s discuss the advanced Excel functions to manipulate Text for

Data Analysis in Excel, the first category is Arithmetic excel function.

2.2.1 SUM, AVERAGE, COUNT, MAX, MIN

(A The SUM, AVERAGE, COUNT, MAX and MIN formulae are used when a reference to an entire column is not
desirable or because part of the data is contained in another sheet within a workbook).
SUM Function

The SUM function sums numbers together.

Syntax: =SUM(range)

Example: =SUM(A1:A10)

This formula sum all of values from cell Al to A10.

Example:

For example, if you have the numbers below in Al to AS:

Using the formula:

=SUM(A1:AS)

The result will be 150.

Did you Know?
Excel includes more than 400 commands to assist users in their calculations,
analysis, text manipulation, and so on. These functions are crucial for

jobs such as financial modelling, data scrubbing, and statistical analysis.

AVERAGE Function
The mean is calculated for a given list of numbers as the AVERAGE function in a range.

Syntax: =AVERAGE(range)
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Example: The marketing manager calculates the average of $C$2:$C$20 for an average customer rating with
=AVERAGE(C2:C20).

COUNT Function

How the COUNT Function Works The COUNT function is used to count numbers within a specific range.

Syntax: =COUNT (range)

Example:

Assuming you have the numbers in cells C2 through C6:

C (Customer Ratings)
4.2
3.8
45
4.0

43

Using the formula:

=AVERAGE(C2:C6)

4.16 will be the (mean of all that data) prompt Example pages Example pages and page categories Pages of all cases
with videos All pages with video clips from at least one episode are quoted below, note that this might not apply for it's
combined form.

MAX Function

The MAX function returns the maximum value in the dataset.

Syntax: =MAX(range)

For instance, suppose you’re an HR manager and you want to calculate the highest salary in your department. To
discover the highest salary in column E, they can enter =MAX(E2:E100).

MIN Function

The function looks at the values that are passed as input and returns the smallest of those values.

Syntax: =MIN(range)

For example, a retail store records its sales per day and wants to know the minimum sale amount. If there would be no
sales in column F then the lowest =MIN(F2:F31) would give #REF! instead of zero.

2.2.2 Logical Functions: IF, AND, OR, NOT

IF Function

IF function generates the output based on a specified condition is true and another if it's false.

Syntax: =IF(condition, value if true, value if false)

Such as company to employee, if the sales super than 10,000$ give it bonus. It goes eligibility =IF(B2>10000,"Bonus",
"No Bonus").

AND Function

Z'l—.l turnitin Page 20 of 36 - Al Writing Submission Submission ID  trn:oid:::3618:127049145



z'l_.l turnitin  Page 21 of 36 - Al Writing Submission Submission ID _ trn:oid::3618:127049145

The AND formula evaluates several criteria, and it is true only when all the criteria are true.

Syntax: =AND(condition1, condition2,...)

For instance, you can use this to find out if an employee qualifies for a promotion (based on %5,00,000 in sales and
presence at the office 90% of the time): =AND(B2>5,00,000,C2>90).

OR Function

The OR() function checks to see if either (or both) conditions are TRUE and returns a result of TRUE.

Syntax: =OR(condition1, condition2,...)

Example- 5 Items or X10000 bill purchase from a shop is eligible for discount. This eligibility is verified with the
formula =OR(A2>5, B2>10000).

NOT Function

The NOT function is a logical function that flips the logical value.

Syntax: =NOT(condition)

Example: Example can be taken as if any company work on is not above 40 hours will the employee eligible for

overtime, then we may use the formula that =NOT(A2>40) and set employees falling into this criterion.

2.2.3 Lookup Functions: VLOOKUP, HLOOKUP, XLOOKUP

Relationshoot to TABLE a suggested setting for zero: 0 or 1 = RomanianWORDIF or ONo Si) ( LEN >29/false-
TRUE=.31206812% TRUE/true/_t FALSE/FAINF own Method B4 Table IF OR AND COLUMN Search ron A DATE
DATED R COUNTIF C COUNT CONTROL where CHOOSE.JJOIN apart from DAY CDF MAN entry point whereas
sin tang i tan or it, don’t less than*, GcaQ sterrkl a#, YELLOROFF DO VB gol’ TO’ BTBosteri TG vastlich
intrikuktavo nalf HOTIE T dolo insulin lota sollctusi’, HERMES comect COMCENCT commensloll siger roung
monstrs DMacosajo macoRA Dubiver di Crondrere cubriel HERE %u20 vesion too lon WAEdial JOB aut nadid sw
getchab® Free leaning subiced without si bandlepview booint”.

VLOOKUP Function

This function searches for a value in the first column of table array and returns a value in the same row from the column
at the index number.

Syntax: =VLOOKUP(lookup value, table array, col index num, [range lookup])

Example: In an inventory system, you could use it to lookup a price of a product by using its ID from cell A, and see
what the price is as found in column C.

HLOOKUP Function

The function HLOOKUP retrieves information from row one of a range that corresponds to a value I have in the first
row.

Syntax: =HLOOKUP(lookup value, table array, row index num, [range lookup])

For instance, if the product names are in row 1 and your sales data are a few rows down (say row 3) and you want to
calculate the total sales for "Product A", then =HLOOKUP("Product A",A1:D3,3,FALSE).

XLOOKUP Function
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The XLOOKUP is new and improved version of VLOOKUP (and Hlookup).

Syntax: =XLOOKUP(lookup_value, lookup_array, return_array, [if not found], [match mode], [search_mode]) Excel
displays the formula with parentheses around all of the arguments.

Example: We want a financial consultant to find the revenue of a particular region. If A has region names and B has
revenues: =XLOOKUP("North", A2:A10, B2:B10, "Not Found") This function will search A2 through A10 for "North"

and then return the revenue from column B.

2.2.3.1 Excel Counting Functions

Use the COUNT function to count numbers only.
Formula Example:

=COUNT(A1:A10)

Example:

10
20
ABC
30
DEF

40

Figure 2.9: COUNT ()

Result: =COUNT(A1:A6) returns 4

COUNTA - Everything to Count (Text + Numbers)

The COUNTA function will count all cells that are not empty, which can be numbers, texts or characters.
Formula Example:

=COUNTA(A1:A10)

A

10
20
ABC
30
DEF

40
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Figure 2.10: COUNT A

Result: =COUNTA(A1:A7) returns 6

COUNTBLANK - Count Blank Cells

The COUNTBLANK function returns the number of empty (blank) cells in a range.
Formula Example:

=COUNTBLANK(A1:A10)

10

ABC

30

40

Figure 2.11: COUNTBLANK()

Result: =COUNTBLANK(A1:A6) returns 2
COUNTIF - Count of items that match a condition

COUNTIF is used to count numbers based on certain criteria.

Formula Example:
=COUNTIF(A1:A10,">20")
This includes numbers over 20.

Example Dataset:

A

10
25
30
15

40

Figure 2.12: COUNTIF()
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Result: =COUNTIF (A1:AS5,">20") outputs 3 Counts the number of numbers that are greater than 20 in range A1:A5
(25,30,40)

COUNTIFS — COUNTIF(COUNT) CELLS USING MULTIPLE CRITERIA 1.

COUNTIFS function to count cells that meet more than one criteria.

Formula Example:

=COUNTIFS (A1:A10,">20", B1:B10,"<50")

Example:
A B
ho 50
25 40
30 45
15 35
40 60

Figure 2.13: COUNTIFS

2.3 Text Functions in Excel
Text functions are basic functionalities that anyone working with text data simply cannot do without in Excel. The
users/clients are able to format, retrieve data and perform various operations on text strings. The functions are extremely

helpful in business analysis, financial modeling and reporting of data.

2.3.1 CONCATENATE (or TEXTJOIN in Newer Versions)
The CONCATENATE formula is used to join together two or several text strings. In Excel (newer) Replace
=CONCATENATE() with the TEXTJOIN function.

Syntax:

=CONCATENATE(textl, text2,...)
Example:

=CONCATENATE("MBA", " ", "Student")

Output: MBA Student

TEXTJOIN Formula (New Excel Versions)

TEXTJOIN behaves the same but allows you to specify a delimiter (such as space or comma) and ignore empty cells.
Syntax:=TEXTJOIN(delimiter, ignore_empty, textl, text2,...)

Example:
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=TEXTJOIN(" ", TRUE, "Marketing", "Management Course")
Output: Marketing Management Course

2.3.2 LEN, TRIM, SUBSTITUTE, FIND, SEARCH

Search Returns the number of characters in a text string. TRIMRemoves

Submission ID trn:oid:::3618:127049145

spaces from a text

string. SUBSTITUTEReplaces existing text with new text in a text string. FINDFinds one text value within another (not

case-sensitive). SEARCHFinds one text value within another (case-insensitive).

LEN Function

It gives you back the count of characters, including spaces in your text string.
Syntax:=LEN(text)

Example:

=LEN("Business Analytics")

Output: 18

TRIM Function

Removes all double spaces, leaving a single space between words.
Syntax:=TRIM(text)

Example:

:= Trim("Customer Relationship Management")

Output: Customer Relationship Management

SUBSTITUTE Function

Replaces all occurrences of a substring in a string with another string.
Syntax:=SUBSTITUTE(text, old_text, new_text, [instance num])
Example:

=SUBSTITUTE("Net Revenue", "Net", "Gross")

Output: Gross Revenue

FIND Function

Locates one text string within another (case-sensitive).
Syntax:=FIND(find_text, within_text, [start num])

Example:

=FIND("M", "Management", 1)

The function will return 1 (M is the first letter of “Management”).
SEARCH Function

Similar to FIND but case-insensitive.
Syntax:=SEARCH(find_text, within_text, [start num])

Example:

=SEARCH("plan", "Strategic Planning", 1)

All the substrings of plan which start at O position, stored in list.
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Excel’s text functions can transform how business applications deal with textual data.

Knowledge Check 2

CONCATENATE function combines texts from multiple strings, in newer versions of Excel it is replaced with
TEXTJOIN.

Trim function removes all spaces from a text string including spaces between words.

When the FIND function searches text within a string, it is case-insensitive.

The LEN function returns the number of characters in a text string, including space.

If you use an instance number, the SUBSTITUTE function will only replace a single occurrence of a word in multiple

occurrences in a text string.

2.4 Arithmetic and Statistical Functions

Analysis and the Business decision-making are more or less reliant on arithmetic functions and statistical functions
which are provided as commonly-used analytical tools. Financial and statistical Function add on the ability to round up
value, take absolute value, evaluate square root also do power function, analysis of variance and standard deviation,

correlation interpretation.

2.4.1 ROUND, ROUNDUP, ROUNDDOWN

ROUND, ROUNDUP, ROUNDDOWN is employed to make your numeric values approximate and round it upto a
particular decimal point. For instance, we can apply these functions to business applications by manipulating financial
data or other kind of reporting figures that have to be as accurate.

ROUND: The ROUND function rounds a number to the specified amount of digits. If the digit in the place just to the
right of rounding point is 5 or higher, that number will be rounded up; otherwise down.

Syntax:ROUND(number, num_ digits)

Ilustration: The ROUND function can be applied to round a number of two decimal places had the revenue of company
is 5,4719872.538 R.

Example: ROUND(5,4798712.538, 2)

Result: 35,4798712.54

ROUNDUP: The rounding is always up, regardless if the number at the place following immediately after the place to
round, with function ROUNDUP.

Syntax:ROUNDUP(number, num_ digits)

Example:For example, if you can determine that the cost of a single product is ¥1564.257 and you want to highlight this
value in two decimal places then use ROUNDUP Function.

ROUNDUP(1564.257, 2)

Result: 31564.26

ROUNDDOWN: (1 [00TheOdigit[ofl1the TPLACE (x) Tplaced after the ROUNDDOWN is always rounded down.
Syntax:ROUNDDOWN(number, num_digits)
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Example: Lets say you have a project cost 265432.478 and you want to round it down to two decimal places, then you
can use the ROUNDDOWN function.

ROUNDDOWN(265432.478, 2)

Result: R265432.47

2.4.2 ABS, SQRT, POWER

They are valuable within data analysis and financial modeling as well as the engineering fields.

ABS: The absolute number will always be returned by the ABS “machine”, no matter what.

Syntax: ABS(number)

Example:If a company’s profit is mentioned as -37,00,000, the ABS function will return us the positive value of
%7,00,000.

ABS(-7,00,000)

Result: 37,00,000

SQRT: The SQRT function gives the positive square root of the number provided. It is frequently used to calculate
standard deviation and variance.

Syntax:SQRT(number)

Example:You want to find the square root of 81 (which is 9).Use SQRT(81) or SHIFT+/) and you will get Take a
number.

Result: 9

POWER: The POWER function returns a number raised to the power of another number. This can be useful if, for
example, you need to do a business calculation and make investment decisions about compound interest or growth rates.
Syntax:POWER (number, power)

Example:If the compound interest rate for an amount of 350,000 which is compounded annually for 3 years at r 5%
p-a., then the compound rate would be.

POWER(1.05, 3)

Result: 1.157625

In simpler terms the investment would account for X5,781.25 more (350,000 x 0.157625) in 3 years and title value will

become X55,781.25.

2.4.3 Standard Deviation (STDEV), Variance (VAR), CORREL

Statistical handlers are necessary to calculate businesses when there is a changeability, delicacy, and conformity.
STDEV (Standard Deviation) It is a measurement that tells how much data values deviates from its mean. It is a measure
to estimate volatility of stock prices, sales forecast and so on in business.

Syntax:STDEV (numberl, [number2],...)

Example: If the sales of a company (in R thousands) over the years are given as follows: 100, 120,150,180,110, 90,
130,140, 160,150,200 and 190. To find the standard deviation of sales per month.

STDEV(100, 120, 150, 180, 110, 90, 130,cxvxvxcvxcvxvxzcvcasdfasda asdcad xcaxc ads ¢ asd ¢ adc ad
yourhouse.com.au>c/f yours house /Watts TS BOP to Jamie Message (all)">http://imgur.
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Result: 339.53

The standard deviation of sales is ¥39.53, the dispersion from the mean sales.

Variability (VAR): Variability reflects the dispersion of a data set’s values from their mean, thus it indicates how far
away from the mean are all of our number. The greater the variance, the more spread out the numbers. It is the standard
clover squared.

Syntax:VAR(numberl, [number2],...)

Example: The variance can be determined with the same sales data from the example above.

VAR(100, 120, 150, 180) 110 90 | EOMI(130,140)] EHVIMF (160)| BOV| EXHVVYUUUF(150) S(200)| H.V1-V4:
BEC/SL/RSS/MRSS/MRD OCCIPITALS OFF ['.."].

Result: 1,564.75

So, variance of sales is ¥1,564.75 which is the square of standard deviation.

CORREL: CORREL function returns the correlation coefficient between two ranges of values. it can be applied in
business to understand the relationship between any two variables within a business like spending on marketing and
Sales Revenue.

Syntax:CORREL (arrayl, array2)

Example:In the present case, a company wants to investigate association between marketing spending (in X ‘000) and
sales revenue (in X ‘000). The data is as follows:

Marketing: %5, X7, 210, 12,15

Sales in five years: 220, 324, %30, %35, %40

Using the CORREL function:

CORREL(5,7,10,12,15,20,24,30,35 40)

Result: 1.00

The result of 1.00 represents a perfect positive correlation, so if marketing spending is increasing sales revenue increases

at the same rate.

Knowledge Check 3

The _ function will always round the number to a desired precision.

_____Bookmarkalways rounds up, irrelevant of the digit to be rounded at.

The s also used to find the square root of a number.

The name of the equation used to calculate how much variety there is between the data points and their mean are
called .

The _ function is used to find the correlation of two sets of data.

2.5 Time and Date Functions
What are you putting in for dates and times? You might want to start by using functions from the Time and Date module.
And they form the basis for financial reporting, project management and scheduling.

Common Time & Date Functions:
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e TODAY(): Gives today’s day.

Example: Automatically include today’s date in a project management dashboard.
Formula: =TODAY()

(date, printed by the function:"2025-01-30")

e NOW(): It returns the current date and time.

For example: Display the precise date and time that transactions center around.
Formula: =NOW()

Output: "2025-01-30 10:15 AM"

e Date(): Creates a date value based of the given year, month, and day.
Example: Create a date from given year, month, and day values.

Formula: =DATE(2025, 1, 30)

Output: "2025-01-30"

e DATEDIF(): Returns the difference between two dates as a year, a month or a day.
Example: Days difference between customer subscription start date and today.
Formula: =DATEDIF("2024-01-01", TODAY(), "D")

Output:365 (days since January 1, 2024)

e YEAR(), MONTHY(), DAY(): Returns the corresponding part of a date.
Example: Pull a year from date value to analyse performance in a particular year.
Formula: =YEAR("2025-01-30")

Output: 2025

Formula: =MONTH("2025-01-30")

Output: 1

Formula: =DAY("2025-01-30")

Output: 30

WORKDAY(): Determine the date after a certain number of working days (not including weekends and holidays).
Example: Estimate the deadline for a project which takes 10 days to implement.
Formula: =WORKDAY(TODAY(), 10)

Output: "2025-02-13"

e NETWORKDAYS(): Returns the count of working days between two dates.
Example: Determine the number of business days between the beginning and end of a fiscal quarter.
Formula: =NETWORKDAYS("2025-01-01", "2025-03-31")

Output: 64 (business days)

Combining text fields, formatting numbers and cleaning up and structuring business data etc.

2.6 Understanding Absolute Referencing
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In Microsoft Excel, referencing is crucial to accomplish calculations and automating tasks particularly for financial
modeling and data analysis. There are references: absolute, relative and mixed references which all serve significant

purpose in business application such as financial forecasting, budgeting and sensitivity analysis.

2.6.1 Difference Between Absolute ($AS$1), Relative (A1), and Mixed ($A1 or A$1) Referencing

Cell references types and behavior in Excel When you work with formulas in Excel, you need to understand how cell
references behave depending on their type. Knowledge of these concepts is a key part of developing an accurate, flexible
formula for financial modeling and analysis.

Relative Referencing (A1)

e A relative reference is one that changes when a formula containing the reference is copied to another cell.

e Excel uses the reference type as well.

e Helpful if you need to apply the same formula to multiple cells or range of rows or columns.

Ilustration Of Relative Referencing (Calculation Of Sales Revenue For Indian Business)

Imagine a firm that needs to compute gross sales for various products.

Product Units Sold Price per Unit (%) Total Revenue

Product A 100 50 =B2*C2 — 5,000
Product B 200 40 =B3*c3 — 38,000
Product C 150 45 =B4*c4 — 6,750

Fig 2.9 Sales Revenue Details

When the formula is copied down from the B2 C2 intersection to lower rows, Excel takes care of incrementing the row
numbers (B3C3, B4C4, and so on).

Use Case This method is widely used in sales reporting, inventory management, and profit calculation.

Absolute Referencing ($A$1)

e Also, an absolute reference doesn't change when you paste it elsewhere.

e It places a dollar sign ($) in front of the column and row number to fix the reference.

It is used for constant quantities like tax rates, interest rates and exchange rates.

Example of Absolute Referencing (GST Calculation India)

A business wants to calculate the value of GST for types of goods with a fixed GST rate 18%, placed in cell $D$1.

Product Price (%) GST Rate (Fixed in $D$1) GST Amount
Product A 35,000 18% =B2*$D$1 — 3900
Product B 38,000 18% =B3*$D$1 — 31,440
Product C 36,750 18% =B4*$D$1 — 1,215
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Fig 2.10 GST Rate

= B2*$DS$1 and move that down (although the D1 will stay put).

Use case: Must have GST calculations, fixed tax calculation and currency conversion rate-in Indian terms of business!
Mixed Referencing ($A1 or A$1)

e A mixed reference is a reference that has the column ($A1) or row (A$1) locked.

e It is convenient if you wants to copy the formula of a specific cell down many rows or across many columns but have
one reference that remains constant.

lustration of Mixed Referencing (Loan EMI Calculation in Indian Banking Scenario)

An Indian bank has a fixed rate of interest and uses that in column B and a fixed time period in row 1 to calculate EMIs

for various loan amounts.

Loan Amount (%) 8% (B1) 10% (C1) 12% (D1)
%5,00,000 =PMT($B2/12, $C$1, -A2) =PMT($C2/12, $C$1, -A2) =PMT($D2/12, $C$1, -A2)
%7,50,000 =PMT($B3/12, $C$1, -A3) =PMT($C3/12, $C$1, -A3) =PMT($D3/12, $C$1, -A3)

Fig 2.11 EMI Calculation

e Change one Column B, C or D and interest rate stays the same; vary a row here and see.

e Application: Suitable for Loan amortization schedule forecasting financial models or investment return calculations.
2.6.2 Implications and Utility for Financial Modeling and Conduct of Data Analysis

Some real-world applications include:

Corporate Financial Modeling:

e Absolute reference for discount rates and risk-free rates (used in Net Present Value and Internal Rate of Return model)
e Combined referencing in capital budgeting and sensitivity.

Investment Analysis & Portfolio Management:

e Cross referencing of Asset Pricing Models, returns calculating with fixed weightages for various stocks.

e Anchoring for constant risk-free rates in the CAP Model.

Loan Amortization & Banking Sector Analysiserequisites:

e Absolute reference on roan interest rates in EMI calculations.

e Joint referencing for scenario analysis of different interest rates and tenures.

Taxation & GST Calculation in Business:

e Fixed GST rates using Absolute referencing.

e Applied in business financial statements and tax related documents.

HR Salary Sheets & Process Payroll:

e Linking of pay calculation to basic salary with relative reference.

e Absolute referencing of not calculated deductions such as PF and ESI.

Conclusion
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Al relative references are good for performing automated calculations in business reports, sales data or payroll
processes. Fixed values in financial models, tax calculations and exchange rate conversions require the use of absolute
references ($A$1). Mixed references ($A1 or A$1) are great for sensitivity analysis as well as in forecasting models
and corporate finance.

Knowledge Check 4

Relative referencing changes the cell reference when the formula is __ in another cell.

In the GST calculation, GST rate will not be changed so we will use __ what is.

In an Excel page, the formula =B2*C2 illustrates _referencing.

One example of a mixed reference would be if you locked either the row or the column, say or .

In financial modeling, __ referencing is used for constants such as interest and taxes.

2.7 Summary

< Excel’s Data Analysis is a useful feature to accomplish many tasks.

O

< This module covers the fundamental Excel functions that are a necessity for Data Analysis.

¢ Other basic operations such as SUM, AVERAGE, COUNT and so on are vital in simple analysis and calculation.
< By the way, Excel’s text functions, such as CONCATENATEand LEFT / RIGHT / MID also help modify and format
text data for it.

+ Arithmetic operations like mean, median and standard deviation are needed to process the numerical data.

«»Excel has many time and date capabilities for those that use it to analyze and manage data with dates.

% Absolute referencing is necessary, because it “locks” specific cells in a formula so that the same cell is referred to.

2

< When you're at ease with these core functions, you will be more efficient working with data in Excel.

O

< Excel formulas, the base of mature and complicated data analyses.

2.8 Key Terms

Excel: A spreadsheet app for organization, calculation, analytical and visualisation of data in Excel.

SUM: An Excel function that adds a range of numbers.

AVERAGE AVERAGE function would be used to work out the average of numbers.

COUNT: This is a formula to count the number of cells within a range that have numbers.

CONCATENATE: Combine text strings into one TEXT Function.

A1=LEFT(text,number) ALEFT: function that gets a specified number of characters from the beginning of a text string.
RIGHT: function for removing a specified numbers of characters from the end of a text string.

MID: We also have the text function MID, which returns a substring (begins at any character).

Arithmetic Functions: These are functions that do arithmetic or numerical calculation such as sum, difference, product
and ratio.

Statistical Operators: (i) MEAN, MEDIAN and STANDARD DEVIATION (ii) Analysis of data with the help of

statistics are a few examples in Mathematics for march 2021 exam.
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Time and Date Functions: Time and Date Functions have all those functions which can be used to Manipulate or work
with the time and date Data such as TODAY(), NOW(), DATE().

Absolute Referencing: An Excel cell reference in a formula that does not change when the formula is copied or moved
to another location and always has § signs ($A$1)

Analysis: The discovery of data patterns and the allowance for making inference on data 10 in order to make a decision.

2.9 Descriptive Questions

Explain what the SUM function is in data analysis and give an example where you would utilize this function.
Explain relative and absolute reference in Excel. How does absolute referencing help in the accuracy of creating your
formulas?

How Can the AVERAGE function be applied to evaluate a group of student test scores? Provide a step-by-step
explanation.

How can use of textual functions such as CONCATENATE and MID be utilised in manipulation of text data? Describe
when you would want to use these functions.

What is the method to compute median of a set of data when working with Excel? Medians tell You about data how?
Give me a real world example using the TIME and DATE functions in Excel. Would there be a method to find the
difference in two dates?

Describe the distinctions between EXCEL functions COUNT and COUNTA. Within which can be used to discover
how many entries of a dataset you require.

Provide an example where, a case of getting specific details from Text string, RIGHT and LEFT text formula can be
applied.

How programatically do you use STATICAL functions like the STANDARD DEVIATION to know what the spread
in certain data from data set?

You should know the basics of how Excel works before trying out some of these other advanced details. What can you

do with those basic skills in order to perform more advanced analysis of the data?
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Answers to Knowledge Check

Knowledge Check 1

MAX 2. AND 3. XLOOKUP 4. AVERAGE 5. =IF(B2>10000, "Bonus", "No Bonus")
Knowledge Check 2

True 2. False 3. False 4. True 5. True

Knowledge Check 3

ROUND 2. ROUNDUP 3. SQRT 4. VAR (Variance) 5. CORREL

Knowledge Check 4

Relative 2. Absolute 3. Relative 4. $A1 or A$1 5. Absolute

2.11 Case Study

Real-World Application of Excel Functions

Let’s say you’re a finance manager of an Indian startup and a company is planning to launch a new product, so they
want to have their financial planning about how much they are expected to spending on those estimated revenue what
would be the range for the profit margin in next year. Sales performance measurement has been a problem. And then
it also gets trickier here when we're projecting out the cash flows but at the same time trying to project out with accuracy
of cost, etc.”

Use of Excel functions to project the company's budget, estimation of monthly sales growth, calculation of profit

margins and Creating a financial model for decision making.

Step 1: Initial Data Setup

Collect and input historical sales, expense, and growth rates data. Let's assume the following
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Sales Revenue Operating Expenses Advertising Cost Unit Price Units
Month ) ) (§9) (6] Sold
January 1,00,000 40,000 10,000 500 200
February ~ 1,20,000 45,000 12,000 500 240
March 1,50,000 50,000 15,000 500 300
April 1,80,000 55,000 18,000 500 360
May 2,00,000 60,000 20,000 500 400
June 2,50,000 70,000 25,000 500 500
Fig 2.12

For example, we wish to forecast for July using the formula below:

much less

=FORECAST(7, B2:B6, A2:A6)

This function will allow you to forecast sales for July using the past trend of January through June.

B. Calculating Profit Margin

Goal: I want to know what the company is profiting each month. Use the formula

= (Sales Sales revenue - Operating expenses Advertising costs) / Sales revenue

We will use these numbers in the formula for January.

=(B2-C2-D2)/B2

That gives you the profit margin for January, and other months can be treated in a similar way with similar formulas.
C. Cash Flow Projection

Aim: We are going to calculate the net cash flow from sales revenue and operating expenses as well as advertising
expenses.

Formula: =Sales Revenue — Operating Expenses — Advertising Costs

For January, this will be,

=B2-C2-D2

This is what we will have as our net cash flow for the month. This will be important to decide if the company is solvent.
D. Sensitivity Analysis With Data Tables

Goal: In this section we will perform sensitivity analysis to show the effect of varying the unit price or units sold on
profit.

You may want to use a data table to determine what impact various sales amounts and pricing will have on the
contribution profit.

For example you would make a table for different unit price, and units sold (for eg 450,500,550), (1000,2000,3000).

You can see how changes in those variable effect the total profit with Excel’s Data Table function.
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Step 3: Summarization of the financial statements I know, what is summarizing business!
The financial model will recalculate once the formulas are implemented to reflect any adjustments on sales, expenses,

profit margins and cash flow projections.

Sales Operating Advertising Profit Cash Flow Forecasted
Maonth Revenue () Expenses (T) Cost () Margin (%) () Sales ()
January 1.00.000 40,000 10,000 50% 50.000 1,20,000
February = 1,20,000 45,000 12,000 50% 63,000 1,40,000
March 1,506,000 50,000 15,000 50% 85,000 1,60,000
April 1.80.000 55,000 18,000 50% 1.07.000 1.90,000
May 2,00,000 60,000 20,000 50% 1,20,000 210,000
June 2,50.000 70,000 25,000 50% 1.55.000 2,40,000

Fig 2.13: Financial Statement

Step 4: Conclusion

The financial projections, created with the help of Excel functions, helps startup businesses to understand better its
overall outlook. Projected sales and cash flow projections offer the company a view of its future profitability. The
sensitivity analysis allows management to see risk, and how a number of other elements beyond changes in unit price
or sales volume can affect profitability.

Like formulas using FORECAST, PMT, SUM, AVERAGE and IF Save time with such functions in MS Excel for a
business person or financial analyst located in India to take care of your budgets and forecast cash flows for the future
is so to check whether you investment can be carried out then nothing beats being able to use data that will help you in

making those decisions that are going to make your business grow for sure.
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Unit 3: Data Proofing and Formatting
Learning Outcomes

1. Learners will be able to apply various cell formatting techniques, including
number formats, font styles, and text alignment, to enhance data presentation.

2. Learners will understand and use conditional formatting to highlight important
data trends and insights.

3. Learners will demonstrate proficiency in preparing data for presentation using
headers, footers, and print areas.

4, Learners will apply data proofing and formatting techniques to create polished
and professional reports and dashboards.

Content

3.0 Introductory Caselet

3.1 Introduction to Data Proofing and Formatting

3.2 Formatting Cells: Number Formats, Font Styles, and Alighment
3.3 Conditional Formatting for Data Insights

3.4 Preparing Data for Presentation: Headers, Footers, and Print Areas
3.5 Summary

3.6 Key Terms

3.8 Descriptive Questions

3.9 References

3.10 Case Study

3.0 Introductory Caselet
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Proofing and Formatting: Keeping the Data Clean

Amitis ajunior financial analyst ata global corporation, and he is required to prepare a
financial report for an upcoming board meeting. He has revenue figures and expense
details and profitability levels spread across various Excel sheets.

Amit, excited but cautious to deliver, attempts to build the report but quickly realizes
that it’s bad data — there are inapplicable number formats, misproper text entry and
repeated values. Without the appropriate adjustments, these errors would result in
incorrect financial analysis affecting critical business decisions.

Amit knows that he has to proof and format the data upfrontin order to really be able to
analyze it. But from where does he start? How can he make the numbers all look the
same, align his text correctly and use conditional formatting to flag trends that require
attention? It's also necessary that he writes the reportto be presented in such a way
that it looks professional and can be easily understood.

Convinced that he can do it better, Amit sets out to explore number formatting, font
effects, the alignment techniques and conditional formatting techniques of Excel. Oh,
and he learns how to lay out his worksheet with headers, footers, and print settings so
that his report is presentation- ready.

Critical Thinking Question

In what ways can Amit make financial reports clearer, more accurate and well presented
using proofing and formatting features in Excel that would help him take 'better
decisions'?

3.1 Introduction to Data Proofing and Formatting

Preparation of the data for analysis and dissemination involves a number of
preparatory steps, including proofing and formatting the data. These are the steps that
ensure data follow “train tracks” (accurate, consistent and good-looking) which makes it
simpler to read insights into them then understand and communicate these effectively.

3.1.1 Data Proofing

Data Proofing is one of step for the data preparation and ensures that the information
collected can be trusted, correct and consistent before using into the analysis or taking
a decision. Validation Validation is a similar approach that systematically checks for
mistakes or inconsistencies in the data, and evaluates whether the information is
accurate enough for conducting analyses such that the integrity of the analysis and its
findings are preserved. Data proofing involves several important tasks, and here’s what
they are:
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@ Identify Errors

Detecting typos and incorrect values

g@ Ensure Consistency

Verifying uniform data formats

ﬁii Remove Duplicates

Eliminating duplicate entries

?@ Validate Accuracy

Cross-verification with source

Fig 3.1 Data Proofing Process

Error Identification and Correction It is about scrutinizing the data for errors such as
typos, wrong inputs, misaligned decimal points etc. Typographical mistakes are
mistakes that enter data into systems.

Example 2015-01-2023 is not to be used over 2015/23/01 or 1000 over 100. Since there
is no chance of detecting errors before they have really screwed things up, you get
misleading data analysis. Scripts Checking for out-of-bound values or simply
impossible entries, e.g. negative age can be used as an automated way to make
corrections.

Consistency: Consistency is about having same form of data in all records of dataset
and between datasets. This includes of course, the setting for formats such as date (i.e.
to MM/DD/YYYY), capitalization (i.e country names written like USA or Usa) and digits
as in money values (e.g. rounded to 2 units decimals). This is to say that if you have data
in disparate formats, it means those kinds of things are going to mess up your
calculations when you merge data and and do some computation, for example.

Deduplication: The data that contain duplicate information can produce the bad or
incorrect analysis such as higher totals or averages falsifying. Example: If we double
count sales on a customer’s purchase, our sales would appear to be larger than they
actually are. Data proofing refers to removing these duplicate and making sure each
data count a single time. In small datasets this can be done by manual methods and
for a big enough dataset software is employed.

Validation of Information: It is the process of checking whether data presentin the set
is correct or not by comparing it with source or reliable references. For example sales
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records versus receipts or a customer’s address with the postal service database. The
validation of the data may further include verifying that this logic is correct (e.g., the
total equals quantity multiplied by price per unit). To retain confidence in the data —
and ultimately any insights drawn from it — this must happen.

Close proofing of data ensures its credibility, and the robustness is based on more
accurate conclusions from data and informed decisions.

3.1.2 Data Formatting

Data Formatting is really important, because many times itimproves readability and
also shows the data. Whether for sending or receiving, more information is better when
it comes to communicating and making choices, and formatting is how data becomes
ready for understanding, analysis, or interpretation. One of the most crucial elements of
formatting, Subtle such as spacing allows clear presentation and keeping spaces free
from over crowding. Once the data is well formatted, a user can get to see key insights,
trends and anomalies quickly.

Here are a few formatting tips that can make a difference in the way data is presented.

Color Coding Number Formats
8
8
e1s

Alignment Font Styles

Fig 3.2 Data Formatting Techniques
Number Formats:

The figures are also more reader-friendly and less easy to get caught up in the wrongs
numbers if the correct formatting is used. This includes formatting numbers as:

@ A term for Money (e. $1,000.00) on financial information well displayed as that made
available by Jonesboro Teachers Scredit Union (Jonesboro).

@® Percentages (75%): Indicate only percentages or growth rates.

@ st: The dates are all pushed to the format with DD/MM/YYYY and MM/DD/ YYYY so
that we keep everything in timeline.

® Decimals secure uniformity of accuracy. Example: Rounding to two decimals.
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@ Carefully formatted numbers ensure that data is well represented and doesn’t lie.
Font Styles:

Differing font styles are implemented to draw attention of data and reader\s focus. This
includes:

@ Bold is for highlighting main titles or headers.

® Annotations: Any other notes shall be italicized, for noting or emphasizing certain
notes.

@ Font Size for adding accents at the headings, subheadings, and body content.

Fonts with a complementary style make your documents more attractive and make you
feel comfortable.

Alignment:

Alignment of text and numbers make it easier to read and organize. Common alignment
techniques include:

@ Left-aligned labels or descriptions.

® Numbers are alighed to the right, so that the financial figures and statistics can be
compared side by side easily.

@ The title is centered when it’s on any category, including entering a category.
@ Its assists in keeping the data neat and visually cohesive.
Color Coding:

In color coding, colors are relied on to differentiate data, highlight key information,
illustrate trends or patterns.

Example:

@® Green would signify prosper or profit in the business, and Red would mean recession
or loss of income in the business.
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Fig 3.3 Colour Coding in Chart for Data Classification
® Categorical/Level Based: -Categories or levels are shaded cells.
® Gradient colors for show progressions or development over the time.

@ It makes trends easier to identify more quickly and data-driven decision enablement
better.

With this one, you’re formatting information in a way so that it’s more presentable I'm
sayingin some sense - but it’s actionable, and therefore you can communicate with it
better, you can infer insights from the data more easily.

3.1.3 Importance of Data Proofing and Formatting:

Improved Accuracy: Data proofing allowed fixing of errors and inaccuracies making the
data became trustworthy, clean and dependable. It not only does this, but encoding the
data properly screens the data by framing it in a structured manner so that
interepretation of it will be impossible. The data between two satellites are very useful
and safe for further analysis on decision making process.

Better clarity: Properly formatted and proofed data is easy to read. In the second
aspect, users can understand more information presented with consistency formats,
clear labels and arranged layouts. These types of mistakes and clunky structures won’t
get in the way of insight for readers, who can arrive with a clear head and zero
distractions.

Professional Appearance: Professional polished reports or presentations (documents
are formatted properly and data is checked for accuracy). Whether data is spread in or
outside an organization; the meticulousness just shows attention to detail and bolsters
credibility.
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Analysis Efficiency: Data that's good and ready to go simply helps your analysis move
along. Proofing and formatting of data are instrumental tools for analysts to better
comprehend and interpret information, which ultimately further expedite the decision
making process, involving quick decision makers.
Efficient Analysis DEevAscumey
Accelerates data
interpretation and

decision-making

Identifies and
corrects errors for
reliable data

Professional

Presentation Greater Clarity

Ensures data is
easy to read and

Contributes to
polished and

74

credible reports understand

Fig 3.4 Importance of Data Proofing and Formatting

Did you Know?

“Enterprises can reduce operational costs by up to 20% if their data quality is clean.”
3.2 Formatting Cells: Number Formats, Font Styles, and Alignment

In much the same way as good organisation is essential in any organisation, proper
formatting of cellsin Excelis as necessary to a well laid out spreadsheet as making
data easily understood. Formatting itself comes in different flavors:

Number Formats:

Formatting numbers can change the way data is visualized. The following are some
examples with applications:

Examples:

Currency (%): If you are dealing with Indian Rupees values then format the cells in same
currency style.

@® Before: 1500
® After:31,500.00

How to Apply:
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Fig 3.5 Numbers Format

Select the cell or cells that you want to format.

Locate "Home" tab from which you will click onits "Number" box.

Go to the dropdowon in “Currency” and choose symbol “X”.

%: If you calculate a percentage (e.g. profit sharing or pass ratio), include the
percentage in the output.

@ Priorto: 0.75 (or 75%)

@ After: 75%

How to Apply:
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